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1.  MODULE 2 OVERVIEW 

1.1 Overview 
This course is intended to give the MDOT Roadway Design and ROW users a wide 
range of instruction for the various workflows during MDOT’s Pre-Construction 
phases A and B.  Users of this document will learn how to navigate and utilize survey 
data created in the District’s Preliminary Survey process and use that data to 
produce Final ROW plans, Acquisition Maps, Final Construction plans, 3D models, 
and other field deliverables. 
 
The Design and ROW phases are critical to MDOT’s Pre-Construction and 
Construction processes in the fact that design data and plans are provided to utility 
companies, other Pre-Construction Divisions, District surveyors, District inspectors, 
contractors, and GIS.   This data is far-reaching in regards to stakeholders and it is 
imperative that this data is accurate, easy to understand, and kept up-to-date 
throughout a project’s lifecycle at MDOT.   
 
One key to making these processes go smoothly is directly tied to full 
implementation of ProjectWise which is the first topic covered in this document.  
The ProjectWise section covers detailed steps for Roadway Design utilizing MDOT’s 
ProjectWise environment in their daily workflows such as quickly accessing initial 
and additional survey data,  creating consistently named files for downstream 
clarity, and sharing and accessing design data with other Pre-Construction divisions 
such as Bridge, Hydraulics, Geotechnical branch, and Traffic. 
 
OpenRoads is another key to providing accurate and up-to-date downstream design 
data to MDOT stakeholders.   Every major grading project that’s been constructed in 
recent years has utilized 3D models and Automated Machine Guidance (AMG) to 
perform the grading.  OpenRoads will allow the Roadway Designer to construct 3D 
models in its design process and deliver to District personnel and eventually 
contractors saving time, money, and errors associated with re-engineering design 
data for field use.  The 3D process and new dynamic horizontal and vertical tools are 
also critical in discovering and eliminating errors in the design process instead of 
during construction.   
 
OpenRoads technology represents Bentley’s continued evolution of merging 
functionality of Bentley’s survey, road design, drainage analysis and design, bridge 
modeling, and construction activities.  It, along with ProjectWise, are the key to 
moving data fluidly throughout MDOT’s project lifecycle.   

 
Topics that are covered in this document include new OpenRoads tools Terrains, 
Horizontal Geometry, Vertical Geometry, Templates, Superelevation, Corridor 
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Modeling, 3D deliverables, Cross Sections, and how to mesh these new tools with 
legacy GEOPAK tools to create the optimal design plans.   These are core 
engineering processes for Roadway and ROW users and it is imperative to learn 
these new tools because of their ease of use, dynamic capabilities, and the eventual 
removal of legacy GEOPAK tools.   

1.2 Target Audience 
This module is recommended for the following audience(s): 

• MDOT Roadway Design users  
• MDOT Roadway SMD users     
• District Plan Production users 

1.3 Prerequisites 
• Knowledge of MicroStation. 
• General survey knowledge. 
• General Transportation Engineering knowledge.  

1.4 Course Objectives 
After completing this course, the users will be able to: 
ROADWAY DESIGNER 

• Navigate MDOT’s ProjectWise structure 
• Properly create files in ProjectWise 
• Work with survey data and terrains 
• Create and annotate horizontal and vertical geometry, etc.  
• Calculate superelevation 
• Build templates and corridor models 
• Place and edit civil cells 
• Properly drain 3D models. 
• Establish right-of-way 
• Calculate earthwork with the surface to surface process.  
• Create cross-sections with OpenRoads 
• Create plan and profile sheets 
• Create PDF plans 
 
ROADWAY SMD USERS 
• Navigate MDOT’s ProjectWise structure 
• Properly create files in ProjectWise 
• Work with survey, property, and design data 
• Utilize horizontal geometry to create parcels 
• Produce Acquisition Maps 
• Send web links to utility companies 

 



 
MODULE 2 OVERVIEW  Software Covered 
 

                                     3  

               

1.5 Software Covered 
Software tools that will be covered include: 
 
ProjectWise 
MicroStation 
GEOPAK 
Bentley Map 
Print Organizer 
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2. PROJECTWISE 

2.1 Section Overview 
ProjectWise (PW) is the project collaboration and content management software 
that houses MDOT’s engineering related documents.   It provides capabilities for 
information sharing, cross-functional work process management, and content 
management to help improve agility and increase transparency throughout the 
project lifecycle.    
 
ProjectWise provides MDOT managed workspaces, consistent file naming/folder 
structure, up-to-date design/survey data for all stakeholders at all times, automated 
attributes for sheet creation,  a secure method of working with external MDOT 
stakeholders, and much more,  all leading to a very productive environment within 
the agency.   

 
This Section introduces MDOT’s ProjectWise environment, file creation processes, 
file management, etc.  For more details of commands and processes not covered in 
this document, utilize ProjectWise’s Help as shown below.  
 

 
 

 

2.2 Section Prerequisites 
• Fundamental MicroStation proficiency 
• Understanding of survey, design, and right-of-way terminology 

 

2.3 Section Objectives 
After completing this section, you will be able to: 

• Navigate MDOT’s ProjectWise folder structure 
• Create and open files in ProjectWise 
• Check Out and Check In Files 
• Import documents 
• Email a ProjectWise link 
• Search MDOT’s ProjectWise folders 
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2.4 MDOT’s ProjectWise Processes   

2.4.1 Local Working Directory  

When logging into ProjectWise for the first time you will be prompted to create a 
working directory (Example: c:\pw_working\mdot_pwapp\jsmith).  Click Yes to 
create this directory.  This will be the local working directory used by ProjectWise to 
house files temporarily when they are checked out and being worked on.  Do not 
open or delete files directly from this directory.  Use the Local Document Organizer 
inside of ProjectWise Explorer to manage the local working directory. 
 

 
Notes:  

• The working directory is created at the user’s workstation.  If you log in to 
ProjectWise from another workstation, you may see this dialog again and 
need to create it there also.    

 
• GEOPAK  .RSC files and MicroStation preferences are also saved locally at the 

location below.   
 

C:\Users\John.Doe\AppData\Local\Bentley\PowerGEOPAK\8.11\OQ4n1D1p
0OEPifXB1vNrKw 

2.4.2 Managed Workspace  

MDOT has implemented a managed workspace environment for ProjectWise.  
These are MicroStation workspaces for each Division pushed out to the end user 
and updates are checked for and loaded each time a user opens ProjectWise.  The 
first time a user opens ProjectWise, the workspace load time takes several minutes 
because the entire workspace is being downloaded.  In subsequent ProjectWise 
sessions, only workspace files that have been modified are downloaded so the 
download time is generally a matter of seconds.  The main benefit of the managed 
environment is that everyone is working with the same up-to-date workspace.  An 
example is that if a cell is added to a cell library, the cell library is pushed out to all 
users the next time they open ProjectWise. 
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2.4.3 PW Interface 

Roadway Design users should make sure their PW Interface and View is set as 
shown below.  RWD should be chosen for the Interface and MDOT View chosen for 
the View.  ROW users should set the interface to ROW and View to MDOT view, 

 
 
If these selections are not shown, turn these on by choosing View -> Toolbar -> turn 
on View and Interface.  Then select RWD in the interface and MDOT View.    

 

2.4.4 Folder Structure 

MDOT’s engineering documents created during the pre-construction and 
construction phases of a project are found in the District (D1, D2, D3, D5, D6, D7) 
folders located under Documents as shown below.   

2.4.4.1 Active Project folders 
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Under each District folder, counties for each District are listed.  Below each county, 
the FMS Project numbers and then FMS detail are listed.   

 
 
10*000 details – Pre-ROW Detail. 
20*000 details – ROW Detail 
30*000 details – Construction Detail  
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2.4.4.2 RWD Working folders 
Below is an image with the FMS Details expanded which highlights the directories 
where Roadway Design performs Phase A and Phase B related work. 
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2.4.4.3 Designer-Staging folders 
 
Designer-Staging folders are folders used for submittals of PDF plan sets by 
designers at various stages of project development.  
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2.4.4.4 Workspace folder 
Below is the workspace folder where each division will access MicroStation related 
Seed files, PLT settings files, Features, cell libraries, etc.  RWD is intended for 
Roadway users. 
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2.4.4.5 Survey Folders 
Accessing Survey Data is discussed in the ACCESSING SURVEY DATA section of this 
document.  

2.4.5 Creating files in PW 

2.4.5.1 Advanced Wizard 
 

1) In ProjectWise Explorer, locate the folder where you want to create a new 
document.  For Roadway Design this location is in the RWD-CADD_Files_A folder,  
District/County/FMS/20*000 details/RWD/RWD-CADD_Files_A 
Note:  For this example we will be using Adams County. 

 
 

Navigate to the appropriate county folder. Look for the correct FMS number 
associated with the project and the correct project detail code. 

Example:  D7\Adams\102942\201000\RWD\RWD-CADD_Files_A 
 

 
NOTE: Before continuing to the next step make sure to have the correct folder 
highlighted where the new document will be created. 
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2) With the correct location selected, create a new document by right clicking the folder 

and choosing Document -> New -> Document from the drop down menu. 
 

 
 

NOTE: Alternatively, you can also open the creation wizard by right clicking in the 
top right window (not on a file) and selecting New -> Document. 

 

 
 

3) Once you selected the above methods for accessing the Document creation wizard, 
select Advanced Wizard then press OK. 

 
 

4) The next screen that will appear is the Welcome to the Advanced Document 
Creation Wizard. Click Next to proceed to the next window.  
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5) Select the correct Target folder where the new document will be created. If you did 
the first step, then the location should already be selected for you. Click Next. 

  
 

6) After you have selected the correct location for your new document, you must now 
select the appropriate seed for your document. Ex: seede2014.dgn 

 
 

The first time you create a new type of document, you will need to navigate to the 
correct location of the seed file as shown in the steps below.  The next time you 
need to create the SAME type of document it will appear in the bottom selection 
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window and you just choose Select from recent templates.   
 
When you click Select next to the Use ProjectWise document as a template, the 
following dialog box will appear. 

 
 

Navigate to the correct location by selecting the drop down arrow in the Folder 
dialog location (1) and then choose the Workspace folder (2). 
 
Navigate to Standards -> RWD -> Seed -> East or West. 
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Choose the appropriate Seed file and choose Open. 
 

 
Notes:   

• Choose the seede2014.DGN (or seedw2014.dgn if West SPCS) for creating a 2D 
Seed file.  

• The Seed Files labeled “Not Used Anymore” are not used on new projects but are 
still used if the project was originally created in DGN files with International Feet as 
their unit. 
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7) Click Next on the dialog shown below. 
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8) Now that ProjectWise knows what seed file to use to create your new document, it 
must be named.  This will provide a standard naming convention used for all 
working DGN files at MDOT.  To do this, just click the drop down arrow next to the 
appropriate selection box.  
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Notes:  
• The file types available for the RWD process are shown below. 

 
 

• Optional_Desc adds a user defined description to the file name.  An example 
would be 20Scale for a 1”=20’ scale alignment file if multiple scaled drawings 
were needed. 
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9) Once you have selected the correct Sheet Type and Discipline, click the Generate 
button to generate the next Sequence Number.  This assures that no two 
documents have the same name.  Preview the name and then choose Next. 
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10) The next dialog is filled with some optional attributes to fill out. You can fill 
them out or simply skip this dialog by clicking Next.   
 
Note: The document attributes are specific to each interface. 
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11) In the next Dialog box you will fill out the Description for the new document. The 
dialog box may be left as is but this description is listed next to the file in PW and 
can add valuable information to what is contained in the document.

 
 
 

Once you have entered the Description, click Next. 
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12) The Final Dialog is a review of the Document properties. Review this information to 
ensure that all properties to the new document are correct. 

 
 

13) Click Next and your new document will be created. Once the wizard is done creating 
your document, click Finish. 

 
Now that your new document is created, double-click on it and MicroStation will open the 
new document which is shown below. 
 

 
 

Notes:  
• The above workflow for creating new documents can be used to create any 

document type including Word, Excel, etc. 
 
• File names begin with the division that created them. Example: SRV, RWD, BRD, etc.  
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• Some of the dialogs you go through when creating a document can be bypassed by 

going through the process below and checking the Skip page checkmarks under 
Wizard Pages.  These are normally all unchecked but ones you may want to skip are 
checked below.  

 

 
 

• Creating new files from within MicroStation or any application will invoke 
ProjectWise’s New Document application and the file will be created in 
MicroStation.   
 

2.4.5.2 Bypassing the Wizard 
The Advanced Wizard is primarily used for creating DGN files in order to obtain a 
standard naming convention.  Using No Wizard can be used for other methods such 
as dragging and dropping external files, creating test files, and various MicroStation 
processes (i.e. exporting a terrain.) When using No Wizard, attributes are not 
applied. 
 

2.4.6 Importing Documents 

The simplest method to import documents into PW is to select, drag, and drop from 
Windows Explorer.  In addition to covering importing documents, this section will 
cover Scan References and Link Sets Operation.  The scan references tool looks 
inside each DGN file, searches for any reference files attached, and tries to resolve 
them by changing them to appropriate PW references.  This means that when a 
document is open, ProjectWise sees the reference files and downloads a copy to the 
local machine automatically. 
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2.4.6.1 Importing Documents 
 
1) Open and login to ProjectWise and locate the desired folder to drop the 

documents into.  For this example we will use 
D2\MARSHALL\102207\203000\RWD\RWD-CADD_FILES_A 

 
 
2) Locate the existing files on the local machine in Windows Explorer. For this 

example we will use D:\temp\102207. 
3) Select all documents in the windows directory.  Once you have selected all of the 

folders and documents, hover in the Windows Explorer window and click and 
hold down the left mouse button, move your mouse into the ProjectWise folder, 
and release the mouse button. 
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4) The Import Directories dialog box opens and gives you the following options. 
Make sure you check Include Subdirectories. Then click OK. 

 

  
5) This will begin copying the folders and documents. 
 
Notes:  

• If you do not see all of your folders or documents, you should hit the F5 key on your 
keyboard. This will refresh your view in the same way it does with Windows 
Explorer. 

• Review content and folder structure and clean any unnecessary files/folders prior to 
import.   
 

2.4.6.2 Scan References and Link Set Tool 
The Scan for references tool is typically run after the document is imported in 
ProjectWise in order to establish links.  If the DGNs are created in ProjectWise and 
no references are attached, there is no reason to run this tool as ProjectWise 
records when the attachment action happens. 
 
In order for ProjectWise to automatically locate and copy reference files, we have to 
tell it that the files exist and where they are.  The tool we will use for this process is 
the Scan References and Link Sets tool.  You can access this tool from two locations. 

• Under the main menu bar Tools -> Scan References and Link Sets 
 

• Using the right click on a folder and find the Scan References and Link Sets 
on the drop down menu. 
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Both methods work the same way, however, the right click method allows you to 
pre-populate some of the following dialogs.  This will ensure that you do not try to 
scan the whole data source, which will take an excessive amount of time.  
For this example, we will use the right click method. 
 

1) Highlight the folder in ProjectWise where you imported all of the folders and 
documents. 

 
2) Right mouse click and choose Scan References and Link Sets. 

 
3) Click Next on the welcome page. 
4) Check both boxes and click Next. 
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You will notice that the directory is automatically filled in. Click Next.  

 
 

5) Check the folder name for the Master Folder Settings dialog and click Next. 
 

 
 
Note: If you enable the Priority Search on the next dialog, you can choose which 
folders to find and attach the references from in case you have more than one file 
named the same in different folders.  Use the browse button to navigate to the 
proper folders and subfolders.  
 

 
 

6) We will not enable the Proximity Search Options. This option allows you to search 
up in the directory structure. Click Next. 
 

7) You now have the option to create a log file. It will create a text file with all of the 
paths that are found and the ones that are not located for whatever reason. This file 
can be created on your local computer by hitting the browse button and navigating 
to a folder. For this example we will not save a log file. Click Next. 
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8) Click Finish to begin the scanning function. 

 
Note: This process will take a few minutes depending on the number of files being 
scanned. It is worth the time taken to do this task, because ProjectWise can now 
locate all the reference files without you having to manually reattach each one. 
Once the scan references process is finished you will notice that some of your files 
will have a small icon attached at the bottom of the Bentley MicroStation icon. 

  This means that this file has references attached. By right mouse clicking on 
the file and choosing the Set -> Show References you can see which files are 
referenced. 
 
 
Notes:  

• This process will take a few minutes depending on the number of files being 
scanned.  It is worth the time to do this task, because ProjectWise can now 
locate all the reference files without you having to manually reattach each 
one. 

• Once the scan references process is finished you will notice that some of 
your files will have a small icon attached at the bottom of the Bentley 
MicroStation icon.    This means that this file has references attached. 
By right clicking on the file and choosing the Set ->Show References you can 
see which files are referenced. 

• Scan for Reference tool works as follows in the background based on the 
selections in wizard: 
o Downloads and opens every document selected, either picked 

individually or by folder and subfolders. 
o Reads reference file name information from the drawing file it has 

opened and searches for the reference file name in the ProjectWise 
folder(s). 

o The priority list is important in case you have duplicate reference files 
imported.  ProjectWise will link back to the first file name it found based 
on priority of the folders where that file lives. 

o Once the reference file is found, ProjectWise records association based 
on the internal document ID so file names and location within 
ProjectWise is not important anymore. 

o If the reference is not found in the folders, the tool will report in the log 
as an error.  However, what that error means is ProjectWise did not find 
a reference file in the folders given; that reference file may have been 
imported to the different folder or not at all. 

o Once all references are found, the master document is checked back in 
and the tool proceeds to the next file on the list. 
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2.4.7 Opening Files in PW 

To Open a file: 
1) Double click the file and it will be checked out and opened.  This process is the 

preferred method. 
2) Right click the file and choose Check Out or Open as shown below. 
 

 
 
You can see other document commands in the menu above.   The ones in red are 
used often and explained below.  
Check Out – Downloads the copy locally for work, but does not open in application. 
Check In – MDOT automatically checks in dgn files, however, this command checks 
any document in and saves the changes.   
Export “Send to Folder” - Copies to the local computer but does not check out, 
hence changes are not saved to PW.  
Export –Locks the file and the changes can be re-imported. 
Copy and Paste – Used to copy files from one PW folder to another.  
Delete – Deletes the file.   
Free – Is not highlighted but moves the file from the “check out” state, but does not 
save changes.  ALL WORK WILL BE LOST IF YOU CHOOSE FREE.  
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2.4.8 Checking in Files in PW 

When a file is checked out, a red check replaces the pencil (write) next to the file.   

 
 
When you exit MicroStation files, PW is set to automatically check the file in.  With 
other file types, you will be prompted to Check In the file in as shown below.  
  

 
 
NOTE: FREE will check the document in but not save any changes.  Generally you 
will not use Free as it could cause loss of data.   
 

2.4.9 Preview Pane 

At the bottom of the preview pane of the ProjectWise Explorer interface, there are 
tabs that may provide further details on selected files.  An example is the Photo 
Preview tab that previews content of a selected word document, image or design 
file. 
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2.4.9.1 Example Survey document 

 

2.4.9.2 Example Design file selected 
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2.4.10 Local Document Organizer 

 
The Local Document Organizer is primarily intended to aid the user in managing 
ProjectWise files that have been stored locally. The Organizer is the only tool that 
should be used to manage both Checked Out and Copied Out files from ProjectWise. 
 
1) Within the ProjectWise Explorer menu, navigate and click the Tools menu pull-

down, and select “Local Document Organizer” from the menu. 

 
Note:  
The icon shown below may also be used to invoke the Local Document Organizer. 

 
It will open the Local Document Organizer dialog box. 

 



 
PROJECTWISE  MDOT’s ProjectWise Processes 
 

                                     33  

               

2) Select the red checkmark.  You will notice that all documents currently checked out to 
you are listed. 

 

 
 

3) Select all the documents.  This can be done by selecting the top file and pressing Ctrl+A 
on your keyboard. You can also select them one by one while holding the Ctrl key on 
your keyboard. Right click the documents and select Check-in to update all copies 
within ProjectWise. 
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Note: There are several options available from this drop down menu. 
 

• Update Server Copy – This option copies the changes made to a file back into 
ProjectWise for everyone to see while leaving it checked out to you and 
allowing you to continue to work on the file.  No one else can modify it. 

• Check In – Leave Copy – This option sends modifications and checks in the file 
to ProjectWise.  The document becomes available for other people to check 
out and make modifications while leaving a local copy on the local computer. 

• Free – Leave Copy – This option does not send any modification done to 
ProjectWise and it also frees the document so everyone can check out and 
modify if needed.  It also leaves a local copy of the document. 

• Free – This option does the same as above, but deletes the local copy from 
local computer.  
** Free and Free – Leave Copy should be used sparingly due to the fact that 
any changes made to the document will be lost once you free it.  The 
document on the server will continue to be the last known good document 
and will be available for use by others.  The reason for ProjectWise leaving the 
local copy is performance.  When user checks out a document in ProjectWise 
it knows if there is a local copy to update and only sends the delta to that file.  
If no local copy exist, a complete file has to be downloaded.
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4) Within the Organizer, locate and click the Open Book icon to display all Copied-Out 
documents. 
 

 
 
 

5) Select all the documents. This can be done by selecting the top file and pressing Ctrl+A on 
your keyboard. You can also select them one by one while holding the Ctrl key on your 
keyboard. Right click the documents and select Purge Copy to remove all copies of documents 
from your computer.  These files are temporary backups from the pw_working directory.  

 

 
 
Notes: There are several options available from this drop down menu. 
 

• Check Out-will check out all document’s within the list to your user account 
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• Refresh Copy- will update all copies that are located on your computer 

 
• Purge – removes all copies from your computer 

2.4.11 Emailing a ProjectWise Link 

1) Locate the file that you would like to send a location link for and highlight and right click 
the file. 

 
2) With the right click menu up, navigate to the bottom and highlight Send To. Then select 

Mail Recipient As Link. 
 
 
 

 
3) Outlook will open.  Choose the recipients and send the email like you normally would. 

2.4.12 Sub-folders 

Although the user has the ability to create sub-folders, it is not the ideal workflow to create 
sub-folders in ProjectWise.     
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2.4.13 Attributes 

Attributes are information associated with files to further help describe the file and search 
for the file in ProjectWise.  ProjectWise has ability to enter additional document attributes.  
Some of the attributes are delivered with the application and some are custom configured by 
MDOT.  Project number, route, county, file type, design team, etc. are types of attributes 
configured by MDOT.  ProjectWise system attributes are located under the general tab in the 
properties and the custom attributes appear under the Attributes and More Attributes tabs. 
Some attributes may be prepopulated at document creation based on the rules set up for 
MDOT.  Also some of the attributes may have a value list to choose from. 
  
In order to review or update document attributes follow the procedure below: 
1) Right click on selected document and choose Properties, or also by selecting the 

document and pressing the space bar. 
2) The general tab shows PW system attribution like document name, file name, etc. 
3) Navigate to the Attributes tab to explore MDOT specific attribution. 
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4) You can enter and modify information in the form fields and click Save button to update 
the record. 

5) Click Close to dismiss document property dialog. 
 
Notes:  

• Document attributes can be filled in at the time of document creation when using 
advanced document creation wizard. 

• If the attribute tab is blank or different, most likely you need to choose the correct 
interface in ProjectWise Explorer menu. 

• Attributes can be copied from one file to another file using the commands below and 
choosing the file to Copy Attributes, selecting file(s) you wish to copy attributes to, 
and then Paste Attributes. 

 

2.4.14 Quick Search 

When you are creating documents and project folders, attributes are defined. Attributes are 
used by ProjectWise when performing search queries. The ability to use attributes as search 
criteria is why it is important to include as much information as possible when creating 
documents and project folders. 
 
The search bar is located at the top of the ProjectWise toolbar. 

 
 

  



 
PROJECTWISE  MDOT’s ProjectWise Processes 
 

                                     39  

               

You can type any attribute about a project in this search box and it will find it. The first thing 
to remember is to highlight the appropriate folder you want to conduct the search in. 
 
 
 

 
 
 
Another way you can search is by using what is called a wildcard in your search parameters. 
Example: 
*.dgn 
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If you would like to locate the folder of where the result document resides, right click and 
choose Open Folder.  ProjectWise Explorer will locate selected document in the folder it 
lives. 
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LAB I: PW Processes 
1. Open ProjectWise and navigate to your assigned directory.  
2. Create the file RWD-ALI-001.DGN (Use seede2014.dgn) as your seed file. 
3. Open this file by double-clicking.  
4. While in MicroStation, look at the PW window and you will see the document checked 

out.   

 
5. Exit the file and the document is checked back in automatically. 

 
 

6. In PW, Open Properties of the document you have created. 
7. Navigate to the attributes tab 
8. Enter information to the fields if not already populated: 

• External Project Number 
• Design Team 
• County  

9. Click Save and close 
10. Open properties again to verify changes has been saved. 
11. To view what permissions are granted on a given file or folder choose the “Access 

Control” as shown below.  
 

 
 
12. Open the file RWD-ALI-001.DGN again.  
13. Navigate to quick search bar.  Choose the Train** folder. 
14. Type in *ALI* as a search criteria and hit enter. 
15. Review search results 
16. Reference the file SRV-ALI-001.DGN file from the 101000\SRV folder.  
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3. RWD WORKSPACE OVERVIEW 

3.1 Section Overview 
Parallel with the implementation of SS4 and OpenRoads, MDOT created a new workspace 
interface for each Division based on that Division’s specific workflow tasks.  It is comprised of 
some of the past workspace look and feel such as the “MDOT Main” menu but is streamlined 
with new OpenRoads processes more prevalent.  This section provides an overview of some 
of the new tools and workflows that are detailed in subsequent sections of this document.   

3.2 Section Prerequisites 
• MicroStation fundamentals 
• Knowledge of surveying principals 
• Basics of Horizontal Geometry 

3.3 Section Objectives 
After completing this Section, you will: 

• Be aware of the interface changes made 
• Have knowledge of new OpenRoads tools 
• Easily work with raster data 
• Be aware of MicroStation models 

3.4 The Interface 
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3.5 Project Explorer 

 

3.6 MDOT_Civil 
MDOT_Civil houses OpenRoads new tools.  This document focuses on all tools shown below 
except Survey Processing. 
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3.7 Civil Features 
OpenRoads uses MDOT pre-defined Features for point, lines, complex elements 
(alignments), terrains, templates, etc.  These primarily control level symbology but can 
encompass other tasks such as placing cells, controlling initial terrain display, etc.  These can 
be viewed in Project Explorer and are actually copied to the DGN file when used.   
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A couple of examples of selecting features are shown below.   
Single Offset Partial- 
Copying an element parallel and 
creating existing EP. 

 
 

Create Complex –  
Storing an alignment. 
 

 

 
 

3.8 Civil AccuDraw 
Civil AccuDraw is the method to interact in terms of Station, Offset, and Elevation or XYZ 
Data Points to OpenRoads horizontal and vertical geometry elements.  It is discussed in detail 
in the Horizontal Geometry section below, 
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3.9 Placing Cells 
Placing Cells is now performed through the Horizontal Geometry Place Point tool and 
choosing the correct point feature.   
 

 ->  
 

3.10 MDOT Process Changes with OpenRoads 
This section gives an overview of the process changes for the Roadway Designer moving to 
OpenRoads.  These changes will be discussed in detail in the remainder of this document.   

3.10.1 The Terrain Element 

With MicroStation and GEOPAK SS3, terrain models were introduced as a new MicroStation 
element type which will replace GEOPAK’s TIN file.  Look in the TOPO DGN file for the terrain 
if a TIN file is not present in the survey delivery.   
 
Additional survey, after the initial survey submittal, will be submitted via a SRV-ATOPO-
date.DGN file and will contain the new terrain if a new terrain was generated.   

3.10.2 Survey Processing and the TOPO file 

The TOPO DGN file is now submitted in a 3D file that contains a 2D annotation model. It is 
best practice to reference the topo DGN’s Default model from the SRV directory, as well as 
the annotation model.  If annotation needs to be moved you will need to merge the 
reference into a DGN file located in a writable directory.   If annotation, survey cells, or line 
styles need to be scaled you will need to also merge the references into a DGN file located in 
a writable directory.  This process (at least for scaling related changes needed) will change in 
the near future as implementation of annotation scale will allow automatic scaling of text, 
cells, and line strings.   
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3.10.3 MicroStation Models 

MDOT has generally used MicroStation Default model in all its processes.  With 
implementation of OpenRoads, this will change as 3d models are created in 2d files and 
cross-section models are created in cross-section files.  Models are much more prevalent in 
MDOT’s workflows with OpenRoads implementation.  They will even become more 
important in future releases of MicroStation and OpenRoads (Sheet models, etc.) 
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3.10.4 Context Menus 

Context menus are menus that are invoked by selecting an element and then hovering over 
it to invoke the menu.  The tools available on the menu are dependent on the element 
selected.  

 
 

3.10.5 Horizontal and Vertical Geometry 

These tools provide easy graphical editing and dynamic downstream change processes.  
There is no storage of this information in the external GPK file since all of the elements are 
stored in the DGN file.    
 
Viewing an existing profile is now just the simple process of accessing the View Profile from 
a horizontal element’s Context Menu. It is recommended that all linear elements (Edge of 
Pavement, Shoulder, etc.) be created using these tools, as opposed to the past process of 
using primarily for alignment creation only. 
 

3.10.6 Superelevation 

OpenRoads has a new process for calculating Superelevation with easy, graphical heads-up 
editing capabilities.  Users also have the ability to calculate with traditional GEOPAK tools 
and import.  
 

3.10.7 Corridor Models and Civil Cells 

PAST -> XS Design with 3D byproduct 
FUTURE -> 3D Design with XS byproduct 
 
This new process enables end users to easily create the templates they need to build 
accurate 3D models for downstream use in MDOT’s field construction and inspection 
processes.  Civil Cells provides modeling in areas not easily covered with templates such as 
intersections, bridge areas, cross-overs, etc.  
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3.10.8 Ditch Drainage 

Is now processed for the Corridor.   

3.10.9 Cross-Sections 

Interactive cross-section views that work with 3D data are available quickly through context 
menus, as well as a new process for creating the working cross-sections.   

3.10.10 Earthwork 

Terrain surface to surface calculations instead of traditional average end area will provide 
much more accurate earthwork in a more error free process.     
 

3.11 Working with Raster Data 

3.11.1 Overview and Steps 

Raster data such as aerials, quads, the road network, etc. is now available through the Links 
tab of Project Explorer.  To attach as a raster reference, expand the MicroStation Layers 
folder and double click which item you wish to attach.   
 
1) Go through the following steps in Project Explorer to view the Raster data available. 

 
 

  



 
RWD WORKSPACE OVERVIEW  Working with Raster Data 
 

                                     50  

               

2) Double Click what you want to attach.   

 
 
3) Once attached, you can open Raster Manager to view the file attached and control the 

layers displayed and which views they are displayed in.   
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3.11.2 Road Network 
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3.11.3 Aerials 

D2 shown below. 

   
Note: You see the different aerials available in Layer Display and you’ll need to turn some of 
these layers off (those outside project limits) to increase display speed.    
 
Below is the same image as above, but with Layers off.  
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3.11.4 Quad Maps and Section Lines 

 

 

3.12 MicroStation 
General MicroStation knowledge is assumed for this course but below is an overview of the 
primary MicroStation processes and commands used in this document.   

3.12.1 RWD-Main 

RWD-Main contains most of the needed MicroStation commands.  
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3.12.2 Models  

As discussed in the MicroStation Models section above, models are much more prevalent in 
MDOT’s workflows with OpenRoads implementation.  They will even become more 
important in future releases of MicroStation and OpenRoads (Sheet models, etc.). 

3.12.3 Reference Files 

DGN files can be attached as references through the Reference file command.  The 
Reference file command and dialog are shown below.   

 
 
One of the more recent changes to MicroStation that is extremely useful to the end user is 
using a context menu to Activate or Exchange to quickly edit referenced data.  These 
commands are extremely useful in MicroStations’s daily processes and shown below.  These 
commands can be found by hovering over and then right clicking a reference element to get 
the menu shown below.  

 
 
Activate – Leaves the user in the DGN file they are in but activates the reference so edits can 
be made to the reference file.  Right clicking the windows and choosing Deactivate default 
takes the user back to the original DGN file.  
 
Exchange- Opens the reference file in the same area that the current DGN file is in, allowing 
quick edits.   
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4. ACCESSING SURVEY DATA 
 

4.1 Folder Structure 
Preliminary Survey data is found in the SRV folder located under the District\County\FMS 
number\10*000 detail.    It is preferred practice to reference any DGN files in this folder 
instead of copying them.  GPK’s should be copied to the RWD-CADD_Files_* folder.  An 
example of the SRV folder is shown below.  
 

 
 

4.2 Terrains 
As mentioned earlier in this document: 
With MicroStation and GEOPAK SS3, Terrain Models were introduced as a new MicroStation 
element type which will replace GEOPAK’s TIN file.  Look in the TOPO DGN file for the terrain 
if a TIN file is not present in the Survey delivery.   

4.3 Additional Survey 
Additional survey will be submitted via a SRV-ATOPO-date.DGN file and will contain the new 
terrain if a new terrain was generated.     

4.4 GPK Creation 
If available, the Survey GPK can be copied from the District’s SRV folder and used as the GPK 
during Design.   
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4.5 Copying 
At this time, you should not copy referenced survey elements as this creates a Field Book in 
the DGN file you copied the element to and you may be prompted the following dialog at 
various times. 

 
 
Note: See the Working with Survey Linear Features section under the Horizontal Geometry 
section for proper procedures of working with survey data.  
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5. GENERAL GEOMETRY 

5.1 Overview 
General Geometry offers design and feature standards tools, tools to import and export 
alignments and profiles, rules related tools, and set active commands.  This section 
concentrates on Importing and Exporting and setting the feature definition of an element.   
 

 

5.2 Importing and Exporting 
Although MDOT has its alignment features set up to automatically be stored in the GPK 
(persisted) and annotated when stored as a complex element (and alignment features 
chosen), there may be the occasional need to import and export alignments from and to the 
GPK.  These two commands are available through the task General Geometry as shown 
below.  

 
 

5.2.1 Steps to Export 

1) Choose the Export command from the General Geometry task.  
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2) Choose the elements to export.  

 
3) Reset and you will then be prompted to choose the GPK to export to.  Select it and select 

OK.  

 
4) Open Coordinate Geometry  
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5) Open Tools -> Navigator and choose Chain to verify the alignment was stored in the GPK. 
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5.2.2 Steps to Import 

1) Choose the import command. 

 
 

2) Choose the GPK.  
Note: This may take a little processing time before the next dialog opens.  

3) Navigate and find the alignment and profile you wish to Import. 

 

4) Select Import.  
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5) Fit View, click the alignment, and choose Properties from the context menu.  Then, choose the 
Feature Definition (Alignment Type) to display alignment stationing. 

  
 
 
Notes:  
1) If alignment feature is set and you delete the alignment in the DGN, the Chain in the GPK will 

be deleted.  
2) If alignment feature is set and you use MicroStation’s Undo after an import, the chain in the 

GPK is deleted.  
3) If alignment feature is set and you change the feature type to something other than an 

alignment, the chain in the GPK is deleted.   
4) If you just want to import an alignment but not a profile, make sure you uncheck the Profile 

check box below the alignment or all profiles will be imported with that alignment. 
5) Create Civil Rules - If checked allows for graphical based editing of the imported alignment.  

Civil Rules are not applicable for profiles.   

5.2.3 Features  

To change a MicroStation element to a feature or change the feature of a civil element, use 
the Set Feature tool, choose the feature, and choose the element.  
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5.2.4 Design Standards 

Default and minimum RADII design values have been established and can be chosen for 
curve design.   
 
1. Open General Geometry and the Design Standards Toolbar. 

 
 

 
2. Choose the correct design speed, choose Stopping Sight Distance, and click the Set 

Design Standards toggle.  

 
 
3. Choose the curve command you need.  

 
4. The default radius for that design speed is filled in automatically.  

 
 
If the radius is less than the default you get the yellow triangle with an ! in it. 
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If the radius is less than the minimum you get the red circle with an x in it. 

 
 
Note: Neither one of these symbols show up on a plot.  
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6. HORIZONTAL GEOMETRY 

6.1 Section Overview 
 
This section will cover the basics of using OpenRoads Horizontal Geometry tools to place 
linear and arc features and to create alignments related to the Roadway Design process.  
 
In regards to Horizontal Geometry tools, any elements created with these tools are 
dynamically linked together based on how you construct them.  They offer heads-up 
graphical editing capabilities as well.   
 

6.2 Section Prerequisites 
• MicroStation Fundamentals 
• Knowledge of surveying principals 
• Basics of Horizontal Geometry 

 

6.3 Section Objectives 
After completing this Section, you will be able to: 
1) Create an Alignment DGN. 
2) Work with Survey submitted alignments.   
3) Use Horizontal Tools to draw lines and arcs that will be included in an alignment.  
4) Store and Station an alignment. 
5) Use Best Fit, Reverse Curves, etc. to create complex alignments.   
6) Plot the Alignment at the intended scale.  
7) Use Civil AccuDraw to work with Station/Offset values of Civil elements.   
8) Use Horizontal Tools to draw design elements such as ROW markers and Edge of 

Pavement. 
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6.4 Creating the Alignment DGN file 
Horizontal Geometry needs to be in a 2d model of a 2d Seed file so an Alignment file needs 
to be created using one of MDOT’s 2D Seed files.    
 
Below are the normal settings used in the Advanced document creation wizard.  This step 
was completed in Lab I in this document but shown here for convenience.   
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6.5 Horizontal Geometry Tools 

6.5.1 Overview 

Below is RWD’s Civil -> Horizontal Geometry menu.   Specific commands related to MDOT’s 
Roadway Design processes are discussed in the sections below.    
 
In regards to storing alignments, you can generally ignore setting features when placing the 
lines, arcs, etc. You do want to choose an alignment feature though when storing the 
alignment (Complex command).  This feature is set to automatically write to the GPK and 
station (annotate) the alignment.    
 

 
 
Note: 
These commands work with a dialog and cursor based prompts.  It is generally easier for the 
beginning user to fill out as much as you can in the dialog and then left click to accept the 
cursor based prompts.   

6.5.2 Point Commands 

6.5.2.1 Place Point  
1) Select the Point tool.  
2) Enter the Feature Definition and Name in the tool settings.  
3) Check the Want 3D Point box and enter an Elevation in the field provided if you wish your 

point to have a vertical value.  
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4) Following the heads-up prompt Enter Data Point, move the cursor to the desired location 
then data point to place the point.  
 

 
 
The image above also has Civil AccuDraw invoked which is discussed later in this section.   

6.5.2.2 Equal Space Points  
The Equal Space Points tool inserts a specified number of points, points at a defined interval, 
or a combination of both. The points can be placed between two points or along an element 
and optional offset.  
 
The point can be placed in 2-D (X, Y) or 3-D (X, Y, elevation) in both 2D and 3D model views.  
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6.5.3 Line Commands 

6.5.3.1 Place Line  

 
 
 

6.5.3.2 Line from Element  

 
 
Note: Skew Angle is measured counterclockwise from the element in the direction it was 
created.  
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6.5.4 Arc Commands 

6.5.4.1 Arc Between Elements 

 

 
 
Note: Enter d4 in the radius key-in field to place a 4 degree curve.  (Lower case d.) 
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6.5.4.2 Arc from Element 

 

 
 
Note: Arc Sweep Angle is Curve Delta or Deflection 
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6.5.5 Complex Commands 

After connecting lines and arcs have been created, a complex element can be stored by using 
the command below and choosing the first element (lowest station side), and following the 
remaining prompts.  Note that the complex element is assigned station 0+00 for the 
beginning station.    

6.5.5.1 Store Complex 

 
 

   
With the Ali Design* features, you are prompted for the GPK you wish to write the alignment 
to during this process.  After chosen, the alignment is written to the GPK and annotated.   
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Below are the options for Design related alignment features: 

 
 
Also, note the Name as you will need to add text to it to better identify the alignment.   

Default dialog with ALI Design ML chosen 

 

User modified name. 

 
 
Since the feature above is set to write to the GPK, there are some limitations as to what can 
be used as chain names.  You should only add text to the default name, use no characters 
other than an underbar and if numerals are used, use them as a suffix.   
 
Examples that work: (ML471, MLSR1, etc.)  Examples that do not work (ML471REV, ML49SR, 
etc.) 
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6.5.5.2 Single Offset Entire Element  

 
 

6.5.5.3 Single Offset Partial 
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6.5.5.4 Variable Offset Transition 
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6.5.5.5 Reverse Transition  
 

 

6.5.5.6 Best Fit Alignment 
This tool, Define Horizontal by Best Fit, best fits a course defined by a selected linear object 
or defined between two edges.  It is generally used to Best Fit a surveyed linear element 
comprised of multiple PI’s.  The tool tries to create a tangential alignment utilizing arcs and 
tangents.   
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Choosing this command opens the Create Best Fit Horizontal dialog. 

 
 

6.5.5.6.1 Best Fit Options 
a) Make Complex Element – Creates a Best Fit Horizontal Complex element comprised of 

curves and tangents from selection of a single element.   
b) Make Single Element - Creates a Best Fit Horizontal Complex element comprised of a 

single element (line or arc) from selection of a single element.  
c) Complex By Edges – Creates a Best Fit Horizontal Complex element comprised of curves 

and tangents between two edges.  Complex By Edges is a really useful tool when 
establishing the CL of two edge of pavements.   

 
 

6.5.5.6.2 Envelope 
Defines the tolerance from the intended element that the Best Fit alignment can utilize for 
location.  The tool tries to create a non-kinked alignment utilizing arcs and tangents.  If it 
cannot, it will solve areas it can and introduce gaps.  The user can then adjust (trial and error) 
the envelope to something greater to allow for a total solution.  An estimated beginning 
envelope should be generally 0.1 
 

6.5.5.6.3 Radius Rounding 
Allows the user to specify a round increment for arcs – i.e. 10’ 
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6.5.5.6.4 Include Spirals 
Not generally done unless you know spirals were included during construction of the 
roadway.  

6.5.5.6.5 Default Radius 
Generally leaved unchecked and let the software decide the best radius. 
 

6.5.5.6.6 Feature Information 
The feature and name the user wants to assign the Best Fit element created. 
 

6.5.5.6.7 Steps 
1) Fill out the dialog as shown below.  

 
2) Follow prompts selecting the intended element you want to Best Fit.  
 
You can then use the various reports discussed in the Reports section to review geometry or 
station offset reports of the element created.  
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6.5.6 Modify Commands (Station, Equations, etc.) 

6.5.6.1 Stationing 
The complex command discussed above stations the complex element from 0+00 to a user 
defined station.   To change this stationing,  

 
 

 
Note: Use the Start Station Command only once for an alignment.  After that, you can edit the 
beginning stationing graphically. 

6.5.6.2 Station Equation 
Adds a Station Equation at the intended location.  In the example below the intended 
location is the PT of the arc.  
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To remove Station Equations, select the alignment, open Element Info, and right click 
Equation. 
 

 

6.5.6.3 Copy 
Makes a copy of an element.   
 

 
 

6.5.7 Editing Horizontal elements 

 
 

1) Use MicroStation’s Element Selection tool to choose the alignment.  You can then use handlers 

 to modify the alignment or edit any of the displayed text.  Tag the circle handler on arcs 
to edit the radius.   

2) You can make edits with MicroStation’s Element Info tool as well.  
3) You may be prompted to choose the GPK where the alignment is stored.   
4) The alignment is updated in the GPK when changes are accepted. 
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Note:  You can go to Workspace Preferences to change the color of the handlers and text. 

 
 

6.5.8 MicroStation Commands 

MicroStation tools that are allowed with Civil Geometry elements: 
• Break Element 
• Extend Line 
• Trim to Intersection 
• Trim to Element 
• Insert Vertex 
• Delete Vertex 
• Drop 
• Delete 
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6.5.9 Rules 

Rules are created when horizontal elements are created which allows future edits to be 
passed on to downstream elements and to preserve design intent.   
 
You can remove rules, replace references, lock, unlock, etc. from a horizontal elements 
context menu.  

 
 
You can view a horizontal element’s dependent elements through MicroStation’s Element 
Info tool. 
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6.5.10 Reports 

Horizontal Reports available are listed below.  Choose these commands and then follow the 
prompts to generate the report which is then displayed in the Bentley Civil Report Browser. 

 
 

Select in the Toolbox  Description  

 

Horizontal Geometry Report  

A filter to specify groups of horizontal alignments to 
include in the report data file.  

 

Profile Report  

A filter to specify groups of vertical alignments to 
include in the report data file.  

 

Legal Report  

A filter to specify information on closed alignments 
and reference alignments.  

 

Map Check Report  

A filter to specify information based on plotted data 
rather than the internal precision stored by the 
software.  

 

Station Offset Report  

A filter to specify information on station offset data 
for selected alignments or features.  

 

Point Feature Station Offset Elevation  

Creates a report that contains point name, point 
feature, station, and offset from selected points to a 
baseline MicroStation or civil horizontal geometry or 
survey element.  

 
Station Base Report  

A filter to specify information on station base data 
for selected alignments or features.  

 

Superelevation Report  

A filter to specify information on Superelevation and 
displays data on the selected sections.  
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A couple of report examples are shown below. 
1) Horizontal Geometry Report 

 
 

 
2) Point Feature Station, Offset, and Elevation report.  
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6.5.11 Civil AccuDraw 

6.5.11.1 Overview 
Civil AccuDraw allows the user to input or determine Station, Offset, and Elevation for Civil 
elements and profiles.  It also allows for X, Y, Z input and change of X, Y, Z input.  It is similar 
to MicroStation AccuDraw but its tools are customized for the civil process.  It takes the place 
of GEOPAK’s DP Offset tool as well.    
 
As mentioned, Civil AccuDraw is similar to MicroStation AccuDraw but the two are not 
recommended to be run simultaneously, nor do they work together.  MicroStation AccuDraw 
is off by default in MDOT’s workspace but if you utilize this tool, make sure it is off if you are 
going to use Civil AccuDraw.   
 
Although available on the MDOT Civil menu, Civil AccuDraw is actually docked next to the 
MicroStation Snaps menu in MDOT’s interface because of its importance in civil processes.  It 
is disabled by default.  Also, the menu changes whether you are working in a 3D file, 3D 
model, 2D file, 2D model, or profile view.   
 
Below is the menu on MDOT’s Civil Tasks menu. 
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Below is the menu opened and docked in MDOT’s workspace which is by default at the 
bottom of the window.   
 

 
 
The remainder of this section concentrates on using the Station/Offset process to work with 
alignments and the docked menu.  More Civil AccuDraw use related to working with profiles 
is discussed in the Vertical Geometry section.   

6.5.11.2 Steps 
 
1) In a DGN file that contains Horizontal Geometry, toggle Civil AccuDraw ON.  

      
 

2) Left click and hold down the second button and choose Switch Dialog Mode.   
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3) In the Default or 2D model, choose the Select Point or Element tool.  

 
 

4) The alignment is populated in the dialog.  

 
 

5) As you move the cursor along the element, notice the Station/Offset changing.  

 
  



 
HORIZONTAL GEOMETRY  Horizontal Geometry Tools 
 

                                     87  

               

6) You can choose whatever command you wish and then enter a Station/Offset to send a 
DP for the command you have chosen.  For example, Choose MicroStation’s Place Line 
command.  

 
7) Then enter the Station/Offset.  (115+00, -50 in this example).  Once you enter the 

station, hit the TAB key on your keyboard or select the lock button next to the station.  
Do the same for the offset.   

 

 
 

8) Follow your MicroStation prompt and left click to send the data point.   

 
 
Follow the prompts to finish the command, in this case entering another data point for 
the end of line.  
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6.6 Working with Survey Linear Features 

6.6.1 Survey Linear Features 

Horizontal Geometry tools such as Copy, Single Offset, Arc Between Element, etc. do not 
work with survey linear features.  As mentioned earlier in this document, MicroStation’s 
Copy command does but using this command is not preferred practice.   
 
The process to create elements from survey linear features with the intention of selecting 
with the commands above or storing part or all of this copy as a Horizontal Alignments is to: 
1) Reference the TOPO DGN. 
2) Use MicroStation’s Create Complex Chain command to create a copy in the ALI DGN file.   
3) Drop these elements from complex to line_string and also drop line_strings to lines if any 

part of them will be included in a horizontal alignment.   
 

6.7 Plotting and Stationing Alignments 
The steps for plotting alignments that are stored in the GPK is shown below if needed 
although the processes mentioned above do station (or annotate) alignments.   
1) Invoke GEOPAK’s Design and Computation Manager 
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2) Two dialogs are invoked.  Follow the steps shown in the image below to proceed.  

 
 

3) Choose the Job number. 

 
 

  



 
HORIZONTAL GEOMETRY  Plotting and Stationing Alignments 
 

                                     90  

               

4) Set the Element Type to Chain, check or change the scale, and left click the chain you 
wish to plot.  

 
 

5) Set the Element Type to Stationing and left click the chain you wish to station.  
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6) Your alignment is plotted and stationed.  
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LAB II: Horizontal Geometry 
1. Copy the file JOBSR4.GPK from 101000\SRV folder. 
2. In RWD-ALI-001.DGN, reference the files SRV-ALI-001.DGN and SRV-TOPO-001.DGN from 

the 101000\SRV folder.  
3. Set the GPK working directory.  
4. Create the SR 4 Mainline Alignment.  Alignment and steps are shown below.  

1. Place line from element.  See commands below and at a distance of 500’. 
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2. Use Single Offset Partial to copy parallel alignment XMLSR4 80’ to the right from 
approximately station 1078+50 to 1083+25.  
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3. Place Line from Element – From PT Station 1096+38.307 back 500’.  
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4. Use Arc Between Elements to place the following arcs.  
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5. Store Complex 

 
 

6. Station 1053+50 
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5. Store LR Alignment LR_Tuck. 
a) Place Line from Element (From alignment ML_SR4, 90 degrees, and just crossing 

alignment  
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b) Place Arc Between Element (1000’ radius) 

 
 

  



 
HORIZONTAL GEOMETRY  Plotting and Stationing Alignments 
 

                                     99  

               

c) Store Complex with the Name LR_Tuck 
 

 
d) Station Beginning - 10+00 
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Finished LR 
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6. View the Horizontal Geometry Reports for both ML_SR4 and LR_Tuck. 
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ML_SR4 continued: 

 
 
 
 

7. Create and enter the file RWD-EP-001.DGN 
8. Reference the file RWD-ALI-001.DGN 
9. Use Single Offset Entire Element to create Proposed Edge of Pavement for both 

alignments LR_SR4 (14’ from CL) and LR_Tuck (12’ from CL). 
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7. TERRAIN MODELS 

7.1 Section Overview 
With the implementation of version SS3, MicroStation created a new element type called 
Terrain.  For GEOPAK users, the terrain is the intended replacement of the .TIN file.  
When processing survey, the terrain is created automatically based on certain Pcode 
features being assigned to be included in terrain creation. 
 
This section is intended to introduce the user to terrains and basically shows detailed 
steps of the tools needed to make a TIN or terrain available for vertical geometry and 
corridor modeling work with a brief overview of other terrain model tools. 

 

7.2 Section Prerequisites 
• MicroStation Fundamentals 
• Knowledge of surveying principals 
• Basics of Horizontal Geometry 

 

7.3 Section Objectives 
After completing this section, you will be able to: 
 

1) Import a TIN file as a Terrain. 
2) Make a Terrain Active.  
3) View Triangles and Contours. 
4) Export a Terrain as a TIN or XML.  
5) Have a good understanding of all the terrain tools available.  
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7.4 Terrain Menu 
Below is the Terrain Model menu.  Those identified by a maroon description are more often 
used in design processes. 

 

7.4.1 Create Tools 

 

 Create from File  

Creates a terrain model by importing from an external 
file. Numerous file formats are supported such as USGS 
DEM, DTED, Lidar (*.las), and native products (InRoads, 
GEOPAK, and MX).  

 Create Terrain Model from ASCII File  
Creates a terrain model by importing from an ASCII file 
type using a user customizable format files.  

 

 Create Terrain Model by Graphical 
Filter  

This is the method used to create Design Terrains from 
Corridor Models.  Filters have been set up to basically 
search for specific symbology and then create the “Top 
Dirt” or “Finished Grade” terrains.  This tool is discussed 
in detail in the AMG section of this document.   

 Create from Point Cloud 
Creates a terrain model from MicroStation Point Cloud 
data.  

 Create from Elements 
Creates a terrain model from 3D graphical elements.  
This tool is used quite frequently in Civil Cell 
construction.   

 Create Complex Terrain Model 
Creates a new Complex terrain model by merging or 
appending multiple terrain models.   This process is 
used in the design process in phased construction 
processes.   

 Create Clipped Terrain Model 
Creates a terrain model by clipping an existing terrain 
model and providing an optional horizontal or vertical 
offset.  

 Create Delta Terrain Model 
Creates a new terrain model by the difference between 
2 terrain models or a terrain model and a plane 
(elevation).  

 Create Terrain by Text Interpolation Creates a terrain model from 2D graphics which also 
contain an elevation label.  

 Create Corridor Alternate Surface 
Creates a terrain model from user-specified points in a 
corridor model along any given path.  
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7.4.2 Edit Tools 

 Set Active Terrain Model  Sets the active terrain model file. The active terrain model 
is the model which is displayed by default in profile models 
and is the default target for corridor modeler.  

 Add Features  Adds more features into the terrain that was created using 
the create commands. Example, create the terrain from 
break lines, then add points.  Used more often in Civil Cell 
creation.   

 Remove Features  Removes elements from a terrain which were added by Add 
Features or Create from Elements.  Used more often in Civil 
Cell creation.   

 Edit Complex Terrain Model  
Edits a complex terrain by changing the order of merging, 
change merge or append methods and add or remove 
component terrain models  

 Change Feature Type  Changes the terrain attribute of an element in a terrain 
model. For example, change a break line to a void.  

 Edit Terrain Model  
 

Opens tool settings with several simple editing tools; 
delete, insert and move vertex, delete triangles, and swap 
lines.  

 Create Terrain Model Boundary  
Allows the extraction of implied or stored boundaries from 
terrains with the ability to edit and rule the boundary.  

Remove Terrain Model Boundary  
Removes a boundary element from an un-ruled terrain 
model.  
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7.4.3 Analysis 

 Analyze Volumes  Calculates volume between 2 terrain models or a terrain 
model and plane (elevation). Capable of processing in an 
area (fence) or multiple areas and computing the volumes 
over a range of elevations. Cut and fill factors are also 
options.   Used to calculate surface to surface earthwork.  
The tool is detailed in the Earthwork section of this 
document.   

 Analyze Point  
Reports information about a user-specified point location in 
a terrain model (elevation, slope, contour, slope direction).  

 Analyze Between Points  
Reports information between 2 point locations on a terrain 
model (elevation difference, length and slope).  

 Analyze Trace Slope  Traces along a surface either following a user-specified 
slope value or the steepest slope. Can trace upstream or 
downstream.  

 Analyze Pond  
Analyzes terrain model for ponds (low point) located via a 
data point location on a terrain model (volume, area max 
depth).  

 Create Cut and Fill Volumes  Calculates cut and fill volumes between two surfaces, 
usually an existing a terrain and a surface (terrain or mesh) 
and creates a 3D mesh solid with volume attributes.  

 
Analyze Point 
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7.4.4 Miscellaneous 

 

 Report Crossing Features  
Reports crossing features in a terrain model.  

 Report Conflicting Points  
Reports duplicate points in a terrain model.  

 Graphical Filter Manager  
Build, modify or review graphical filters and filter groups 
used as search parameters for Select by Filter and Create 
Terrain Model by Graphical Filter tools.  

 Export to File  Exports the terrain model to the specified file format, i.e., 
LandXML or native product (GEOPAK TIN, InRoads DTM, 
MX FIL).  

 Label Terrain Contours  
Places additional contour labels to supplement those 
placed automatically by the terrain model element. For 
example, add contour labels in locations where the 
automatic labels are not present.  

 Label Terrain Spots  Places spot elevation labels.  

 

7.5 Importing a TIN file 
If a TIN is submitted with the survey: 
 

1) In a DGN file created from a 3D seed file, choose the Create From File button on the 
Terrain Model menu. 
 

 
2) Choose the TIN file. 
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3) Choose 3d-x-ground as the feature definition and select Import.    
 

 
 

4) Close the dialog above and fit view to see the TIN.   
Notes: 

• Only the boundary is displayed initially. 
• You can rename the model after to Import by going to Terrain Properties on the 

context menu. 
 

5) Reference the DGN file containing the terrain to any DGN file that needs access to the 
terrain (ALI, Corridor, etc.) and make it active as described below.  
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7.6 Set as Active Terrain Model 
To set a Terrain Model as Active (so GEOPAK will know what to cut a profile from, what to 
target with corridor end conditions, etc.), from the context menu, set it as the Active Terrain 
Model. 

 
1) Data point the TIN and a context menu should appear.  Choose Set Active. 

 

 
 

2) Once you select Set Active in a 2d DGN file, a Default-3d model is created. 
3) Open View 5 and open the Default-3d model. 
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4) When the Default-3d model was created, it was referenced to the Default model.  It is 
good practice to turn this reference file off.  Select View 1, open the ref. dialog and turn 
off display for the Default-3d model. 
 

 
 

7.7 Triangle Display 
 

1) Choose, then hover over the terrain boundary and choose Properties from the context 
menu. 
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2) Turn ON Triangles. 

 
Note: You have to be in the DGN that contains the terrain to perform this process.  

 

7.8 Working with a Terrain Model 
In lieu of a TIN being submitted with the survey, just reference in the DGN file containing the 
terrain model and Set Active. 

7.9 Viewing Contours, Flow Arrows, etc. 
1) Choose Properties from the context menu. 
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2) Turn on Contours. 

 
 

 
Notes:  

• On the dialog above, you can also display flow arrows, low points, etc.  
• Contour interval can be controlled by going to Element Information and changing the 

major and/or minor intervals: 
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7.10 Other Context Tools 

7.10.1 Context - Export 

Export to another format (from the context menu). 
 

 

7.10.2 Context - Update from Source 

If the TIN has been changed, you will need to update the Terrain in the DGN file from the 
changed TIN. 
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8.   VERTICAL GEOMETRY 

8.1 Section Overview 
 
This section will cover all tools related to creating and working with profiles with OpenRoads.   
 

8.2 Section Prerequisites 
• MicroStation Fundamentals 
• Knowledge of surveying principals 
• Vertical Geometry Basics 

 

8.3 Section Objectives 
After completing this Section, you will be able to: 
1) Open a Profile View  
2) Create and name an existing profile from a terrain along a Horizontal Alignment. 
3) Basic Vertical Geometry commands. 
4) Import and Export profiles to the GPK.  
5) Annotate Profiles 

 

 

8.4 The Profile View 

8.4.1 Overview 

Users can open a profile view (MicroStation View) of every horizontal element created as 
long as: 
1) There is a terrain active.  
2) You are in the same DGN that the horizontal element exists. 
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8.4.2 Steps 

1) In the file containing the Horizontal Alignment (RWD-ALI-001.DGN) and with the file 
containing the terrain referenced (SRV-TOPO-001.DGN), from the context menu (Select 
and then hover over the element) choose the Make Active command.  

 

  
 
2) Choose and then hover over the Horizontal Alignment you wish to see a profile of and 

then choose the Open Profile Model command.   
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3) You are then prompted to Select or Open View. 

 
 

4) Select a view (any view) from MicroStation’s Views.  

 
 

5) Once the view is Open, DP (Left Click) in the view and the view presents the profile of the 
chosen horizontal element. 

 
 
This view is like most MicroStation views in the fact you can Zoom In/Out, Fit, etc.  It also 
shows the datum elevations and stations.   
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6) Choose the profile element and from the context menu, choose Properties. 

 
 

7) Enter a profile name for the existing profile.  
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8.5 Civil AccuDraw for Profiles 
The basics of Civil AccuDraw and how to invoke and use related to Horizontal alignments was 
discussed in the Horizontal Geometry section of this document.  How to use it related to the 
profile view is discussed below.   
 
1) Toggle on Civil AccuDraw. 
2) Choose the view by selecting the view. 
3) Scroll to see Civil AccuDraw automatically reporting Station and Elevation as you move 

your cursor.  
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4) As with Horizontal Geometry, choose a command and then key in and tab through 
station and elevation to lock them to perform that command on the user provided 
station and elevation.  
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8.6 Vertical Profile Commands 

8.6.1 Overview and Commands 

Vertical Geometry (profiles) commands are listed below. 
 

 
 
Many of these commands are also shown on the pulldown menu in the Profile View.  
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Open Profile Model  
Generates a View that presents a desired feature in profile thus enabling the 
Vertical Geometry tools to interact with the chosen feature.  

Set Active Profile  
Designates which of potentially several profile elements will drive the 3D 
model. The result is the creation of a 3D spline in the 3D model representing 
the combination of the Horizontal alignment plus the Design profile.  

Profile From Surface  
Generates a profile whose elevations are determined by draping onto a 
surface. The surface may be a terrain model, a mesh, or mesh solid.  

Quick Profile From Surface  
Generates a profile of a civil horizontal element by draping onto a surface 
(terrain model, a mesh, or mesh solid).  

Project Profile To Element  
Shows one element's profile in the Profile View of another element.  

Project Profile Range To 
Element  

Shows a portion of one elements profile in the profile space of another 
element.  

Project Extended Profile  Shows, in an element's profile view, the profiles of adjacent elements.  

Place Profile Intersection 
Point  

Indicates in a Profile View where one element crosses another. The point is 
placed at the station and elevation of the intersected element. The 
intersected element must have a designated active profile.  

Profile Report  
Creates an XML report data file that includes information about the selected 
vertical alignments. To run this command the user is prompted to select one 
or more vertical elements from a long section view.  

 

Profile Line Between 
Points  

Constructs a profile line, between two user-defined points.  

Profile Line To Element  
Constructs a profile line, at a delta slope, from a designated location to a 
reference element.  

Profile Line From Element  
Constructs a profile line, at a delta slope, from a reference element to a 
designated location.  

Profile Line Between 
Elements  

Constructs a profile line between two previously placed profile curves.  
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Profile Curve Between 
Points  

Constructs a vertical curve between designated points.  

Profile Curve To Element  
Constructs a vertical curve from a designated point to an element.  

Profile Curve From 
Element  

Constructs a vertical curve between an existing element and a point you will 
designate.  

Profile Curve Between 
Elements  

Constructs a vertical curve between two designated elements.  

Profile Complex By 
Elements  

Constructs a complex profile element from previously placed elements.  

Profile Complex BY VPI  
Constructs a profile complex defined by vertical points of intersection (VPI).  

Define Profiles By Best Fit  
Construct a profile complex defined by best fitting through a selected profile.  

Profile Insert Curve  
Inserts a vertical curve into a profile element.  

Append Profile Element  
Appends additional elements to a previously established complex element.  

Profile Reverse Transition  
Constructs reverse curves between previously drawn elements with an 
optional tangent length between the two curves.  

Profile Offset Transition  Constructs profile elements at an offset from a base element. The base 
element may be a line, arc, spiral, or complex.  
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Quick Profile Transition  
Defines the profile of an element by matching the slope and elevation of 
adjoining elements. Depending on the configuration of adjacent elements, 
either a single crest/sag curve is created or a reverse transition.  

 Profile By Constant 
Elevation  

Defines a flat profile at a given elevation for the entire element.  

Profile By Slope From Point  Defines a profile of an element by computing a slope from a 3D point.  

Profile By Slope From 
Element  

Defines an element's profile by projecting a fixed slope from another element 
with a design profile.  

Profile By Variable Slope 
From Element  

Defines an elements profile by projecting a variable slope from another 
element with a design profile. This command differs from the Profile by Slope 
command only in the fact that you have additional options. Specifically, you 
can define a range instead of the entire element, and there are multiple 
methods of slope rather than fixed slope alone.  

Profile By Vertical Offset 
From Element  

Defines the profile of an element based on a vertical offset. The results are 
similar to Profile by Variable Slope command, except that, instead of 
transitioning two slopes, two vertical offsets are used.  

Profile By 3D Element  
Produces a profile (in profile space) from a 3D element in the drawing.  

Create Civil Rule Feature  Assigns Civil Geometry rules to elements created by tools other than civil 
geometry commands.  

 

8.6.2 Creating a Design Profile 

The process to create proposed profiles is similar to the process of creating horizontal 
alignments.  Create the connecting lines and curves that will make up the profile and then 
choose the Profile Complex By Elements command shown above.  Civil AccuDraw can also 
be used in this process.  Use of these place line and curve commands and the process of 
complexing to create the profile is shown in the lab for this section.   
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8.6.3 Make Active 

An alignment can have one Active Profile which is generally the design profile.   Prior to 
creating a corridor, an alignment must have an active profile to know what elevation to place 
the templates.  This command can be accessed via the context menu of a profile view 
element as shown below.  

 

8.6.4 Project Slope commands 

 
Project Slope commands are generally used to create profiles for elements used as 
references for Civil Cell placement.  An example of this are elements created to represent 
edge of pavement for intersection cell placement.  This profile edge of pavement is required 
as a reference of the intersection cell along with a profiled LR centerline.  The edge of 
pavement is profiled from the mainline alignment by projecting the Superelevation slope(s) 
to it.  This process is demonstrated in the Civil Cell -> Intersection area but discussed here 
since these Project Slope commands are under the Vertical category.   
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8.7 Locating Crossing Roads 
1) Open a Profile View for your mainline alignment. 
2) Locate the crossing alignments in your profile view by using the Vertical Geometry command 

Profile Intersection Point. 
a) Choose the command below.  

 
b) Select the ML alignment when prompted to Locate Element to Show Intersection. 
c) Select a crossing route when prompted to Locate Element Which Intersects. 
d) A Construction line is drawn in the profile view for the local rd. 

  
e) Continue choosing crossing routes that intersect.  
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8.8 Generating Kick-Off Grades 

8.8.1 Perquisites 

1) A Terrain referenced to an alignment DGN file. 
2) An alignment in the DGN you are in.  
3) Primary alignment Grade set, Corridor created, Superelevation applied. 

8.8.2 Steps 

1) Open a profile model for a secondary route (i.e. local rd.) 
2) Choose the Profile from Surface tool. 

 
3) Follow prompts:  

a) Locate First Element to Profile – Select the crossing rd. (i.e. local rd.) 
b) Reset and you will be prompted to Locate Reference Surface – Reset for Active 

Terrain Model.  Do not reset.  In a 3d view, select the pavement area of the corridor 
elements and then reset. 
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c) Follow the remaining prompts and a profile of the primary route’s pavement will be 
plotted on the crossing routes profile.  

 

8.9 Importing and Exporting Profiles to the GPK 
Exporting and importing is discussed in the General Geometry section but steps are shown 
below for exporting a profile.  Importing is used if you utilize GEOPAK’s older tools to create 
the proposed profile.   Exporting has to be done for the existing profile and also the 
proposed profile if it is created in the profile view.  Exporting is required to be able to 
annotate the profile.  Below are steps showing exporting of an existing profile.   
1) Open the General Geometry task.  
2) Choose Export. 

 
3) As prompted, Choose elements – Reset to Complete. 
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4) DP (Left Click) the existing profile. 

 
Note:  

• Make sure the profile has a name prior to exporting the profile.  Choose 
Properties from the profile’s context menu to check. 

5) You are prompted to choose the Job Number.  

 
 
At which point the profile is stored in the GPK.  
 



 
VERTICAL GEOMETRY  Plotting and Annotating Profiles 
 

                                     129  

               

 
6) As stated in the Horizontal Geometry section, open Coordinate Geometry and Navigator 

to ensure the profile was stored.  

 

8.10 Plotting and Annotating Profiles 
We’ll create a new DGN to plot (or annotate) profiles.   
 
1) Create the DGN file RWD-PROFILE-001.DGN (Use the 2D seed DGN file.) 
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2) Enter this DGN file and reference your Alignment and Topo files.  
3) Invoke GEOPAK’s Design and Computation Manager.  
4) Choose the Profile Type and then choose Draw Plan & Profile. 

 
5) Choose the Job Number when prompted. 
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6) Choose the profile you wish to plot.  

 
 

7) Fill out the dialog below and choose DP and then choose the location you want to plot 
the profile.  This can be anywhere in the DGN file but it should be close and to the right 
of the alignments and topo. 
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8) DP anywhere in the DGN, to the right of the alignments and topo references.  
 
9) Choose the PGL Chain which is the chain the profile was taken from.   
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10) Select Draw Cell at XY and then select OK to plot profile.  
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11) The profile plotted. 
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LAB III:  
 
 
1. In RWD-ALI-001.dgn, open the profile view of alignment ML_SR4.  
2. Go to Profile Properties on the Context menu and change the name of the profile to 

XPML_SR4. 
3. Do the same for LR_North (XPLR_North)  
4. Export these profiles to the GPK.  
5. Open the Profile view for ML_SR4. 
6. Choose the command Profile Intersection Point and show the intersection of LR_Tuck 

with ML_SR4.   
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7. Project the existing CL profile to the realigned SR4 alignment.  This allows you to see the 
existing roadway grade when setting your new grade. 
 
a. Open the XMLSR4 profile view and Set the existing profile active. 

 
 

b. Open the profile view of ML_SR4 and choose the Project Profile to Element 
command. 

 
 

c. You are prompted to choose the element to project which is XMLSR4. 
d. You are prompted to select the plan view element to project onto which is ML_SR4. 
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e. The existing CL profile is projected to the realigned SR4. 

  
 

8. Two other control points for setting the proposed grade is where ML_Sr4 intersects the 
existing edge of pavements.  To show these two points: 
 

a. Choose MicroStation’s Create Complex Chain command.  
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b. Choose the Existing EP where it crosses ML_SR4 towards the BOP. 

 
DP to accept and then reset to create the element.  
 
c. DP the same for the Existing EP and ML_SR4 intersection towards the EOP.  
 
d. Turn off the TOPO reference and drop this element.  

 

 
Note: 

• Don’t drop the line_string. 
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e. Choose Set Feature Definition from the General Geometry menu and set the 
existing EP’s to the feature X-EP.  

 
 
f. Choose the Profile Intersection command. 

 
g.  The ML_SR4 and existing EP intersection shown in the ML_SR4 profile view.  
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9. Create the proposed profile PPML_SR4 with the following steps.  

1. Use the Profile Offset Transition tool to offset the existing profile 0.125 from the BOP 
to station 1055+50. 
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2. Drop this element with MicroStation’s Drop command.   

 
 

3. Choose the Profile Line from Element command and place a line tangent to end of 
the offset parallel line created above and ending at station 1062+25.   
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4. Choose the Place Line command and place lines from the previous line placed line 
and the following VPI’s. 
1084+00, Elevation 439.57 
1090+25, Elevation 464.07 
1094+25, Elevation 487.75  
1095+99.5157, Elevation 482.4776 
 

5. Choose Profile Curve Between Elements.  

 
 

 
 

6. Insert the following vertical curves: 
1062+25.00 – 1150’ 
1084+00.00 – 850’ 
1090+25.00 – 350’ 
1094+25.00 – 175’ 
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7. Complex the Proposed Profile.  
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8. Export this profile to the GPK.  
9. Review the Profile Report.  

 
 
Below is just the beginning of the report.  
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Below is the end of the report.  

 
 

10. Create the file RWD-PROFILE-001.DGN 
11. Reference the RWD-ALI-001.DGN file and SRV-TOPO-001.DGN file.  
12. To a general area to the right of the alignment and topo area, plot the existing and 

proposed profiles for ML_SR4.  
13. We’ll go through a few more Vertical related lab commands in the Superelevation lab 

after placing a corridor and applying Superelevation.    
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9. TITLE SHEET CREATION 

9.1 Section Overview 
This section covers the process of creating a MDOT Title Sheet and automatically labeling 
portions of it with ProjectWise’s project related attributes and MicroStation’s Tag Sets which 
are buried in the sheet cells.  

9.2 Section Prerequisites 
• MicroStation Fundamentals 

9.3 Section Objectives 
After completing this Section, you will be able to use Planning Division’s County Map data, 
create a Title Sheet, and label FMS #, County, etc. automatically.   

9.4 Creating a Title Sheet 

9.4.1 Initial Process 

1) Create the Title Sheet DGN file.  RWD-TITLE-001.DGN 
2) Create an alignment file and plot the ML Alignment without PC/PT labels, curve data,  

and bearings through D&C Manager with the properly scaled stationing (AS=500) in this 
example and this will vary with the length of project and the space to fit this in on the 
Title sheet, which requires some trial and error.  RWD-ALI-TITLE-002.DGN 

3) You also need to plot any other road alignments without any stationing/curve/bearings 
unless it is a major cross-road to the ML alignment.  

 
 

4) Enter the Title sheet file and reference the ALI DGN file generated for the title scale and 
reference the Border DGN file.  
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5) Set the Active Scale to the intended scale. 

 
6) Place the Title Sheet.  
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9.4.2 Referencing Planning’s County Maps 

 
7) Reference Planning Division’s County Map.  
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8) Clean up copied or modified text, line styles, etc. as needed.  

 

9.5 Title Block integration with ProjectWise 
Title block integration allows ProjectWise to populate title block information in MicroStation 
with Attributes from the Project Directory.  Once the administrator has set up title block 
integration, tag elements contained within files are automatically populated with data from 
the DGN file or from within ProjectWise. 
 
Example of document attributes in ProjectWise are synchronized with the drawing content in 
the images below.  
 
Tag Data has been set up for all MDOT standard sheets including the Title, Plan, Plan and 
Profile, and Cross-Section. 
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Steps to fill in the Tag Data (Update Title Block): 
 
1) You’ll notice the word Update on the Title sheets in several locations.    

 
 

2) These tags are updated when you run the Update Title Block command.  
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Updated Title Sheet 

 
 
 

 
Once these tags are placed in the title sheet, attribute exchange commands can be used.  
 
Modify Title Block – Allows the user to invoke and edit PW Attributes while in MicroStation. 
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Update ProjectWise – Allows user to push any changes from MicroStation to ProjectWise. 
 

 
 
 
Note:  ProjectWise auto updates the title block every time the DGN file is opened, checked 
out or copied out, so the latest attribute information is reflected in the drawing.  However 
this may be dangerous in a scenario where the DGN is imported into ProjectWise and no 
attribution has been filled in yet.  The first time that the DGN is opened, all mapped tags will 
be removed since these attributes are blank in ProjectWise. Hence, ProjectWise should be 
used from the creation of the drawing rather created externally and placed into ProjectWise. 
 
 

LAB IV: Title Sheet Creation 
 

Title block update 
1. Create the file RWD-ALI-TITLE-002.dgn 
2. Enter this file and plot the alignment MLSR4 through D&C Manager (500 scale) 
3. Create the file RWD-Title-001.dgn 
4. Enter this file and place a Title Sheet Cell.  
5. Reference Planning Division’s District 2 Marshall County Map.  
6. Execute Modify Title Block command 
7. Verify title block in DGN has been updated.  
8. Update Design Team attribute in the properties save and close. 
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10. PLAN AND PROFILE SHEET CREATION AND LABELING TOOLS 

10.1 Section Overview 
Plan and Profile labeling and sheet creation with GEOPAK are discussed in this section. 

10.2 Section Prerequisites 
• MicroStation Fundamentals 

10.3 Section Objectives 
After completing this Section, you will be able to: 
1) Use GEOPAK’s Plan and Profile Sheet Labeling application.  
2) Label VPI’s of a ditch profile.  
3) Create Plan and Plan/Profile Sheets with GEOPAK’s Sheet Composition tool.   

 

 

10.4 Labeling (Plan and Profile) 
Annotation or Labeling is still performed by: 
Establishing the correct text symbology and size and then using MicroStation’s Place Text or 
Place Note tools or GEOPAK’s Plan View Labeling tool.  

 

10.4.1 Place Text and Place Note 
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10.4.2 Plan View Labeler 
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10.5 Creating Sheets 
This section contains specific instructions of how to use GEOPAK’s Plan and Profile Sheets 
application to create the following type sheets: 
 
 
 

PLNPRO – Plan Profile Sheet w/ 
referenced profile. 

 
 

PLNPRO-PLN ONLY – Plan Profile w/o 
referenced profile.  

 
 

PLAN – Plan Sheet, one reference port. 
 

 
 

PLN2 – Plan Sheet, two reference 
ports. 

 
 

PLN3 – Plan Sheet, three reference 
ports. 

 
 

PLN4 – Plan Sheet, four reference 
ports. 
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10.5.1 Steps to Create 

Note: The steps below refer to a different dataset than what is used by most of this 
document (Chain H471 and Profile PP471).  

 
1) In RWD-BORDER-001 or RWD-BORDER-H471-001 (H471 is an optional 

description), reference all sheets you want attached to the Plan and Profile 
Sheet. 

2) Set the Type Sheet and Scale on the dialog below.  The general process after 
that is numbered in the image below.   

 

3) Sheet Composition Button – (1)  
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4) Layout Sheets Button – (2)  
 

 
 
5) Double Click each line and fill out the appropriate info.  If profiles are involved, the 

Profile and Tabular dialogs can be filled out by selecting Identify Cell. 
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6) Select Layout Sheets to place your borders as shown below: 

 
Plan Borders 

 
Profile Borders 
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7) Editing Sheet Numbers –(3)  
Choose all the lines and then select the edit sheet number button on the right to get the 
second dialog shown below.   Fill it out as needed to get the proper DGN file name for 
each sheet. 
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8) Modifying Borders –(4)  
 

Use the following dialog to move borders as needed to best fit topo, etc.  Also, at times, 
you’ll need to enter a reference file, Activate reference, and move text instead of the 
border.  Select Identify and then select the border you need to move.  Profile borders 
need to be moved in even 10' increments. 

 
 

 

9) Sheet Clip – (5)  
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10.5.2 Adding reference Files. 

To add reference files to previously created Plan and Profile Sheets, follow the steps below: 
1) Invoke MicroStation’s Reference Dialog. 

 
2) Copy one of the Plan view attachments (Tools -> Copy).  You will be prompted to DP the 

from and to location which should be the same point. 
 

3) Double click the copy to invoke the Attachment Settings dialog. 

 
4) Change the File Name or Browse to Select the DGN file you wish to attach.  Also change 

the logical name and the tag OK.  Your new reference file should be attached. 

 

LAB V: Sheet Creation 
 

1. Create a Border DGN file (RWD-BORDER-001.DGN).  
2. Reference your alignment, topo, and EP DGN files.  
3. Reference your profile DGN file.  
4. Go through the Sheet Setup process to create Plan and Profile sheets. 

(Names should be RWD-WK3, RWD-WK4, etc.) 
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11. TEMPLATES 

11.1 Section Overview 
Corridor Models are built by dropping templates at intervals along a profiled alignment.  A 
template is basically a typical section comprised of a series of points and components that 
represent breakline features.  Templates are created in the Create Template tool available 
in the Corridor Modeling task.   Templates are stored in a template library (*.itl).  
 
Although MDOT provides a Template Library (RWD.ITL) with standard templates that you 
are encouraged to use, you will almost always have to make edits to the templates to 
handle project specific requirements.  It is even ideal at times to modify things such as 
structure thickness, shoulder width, etc. to match project and typical section requirements.  
This section: 
1) Describes copying the ITL to your Project Directory. 
2) Describes MDOT’s Template Library 
3) Describes MDOT’s Standard Point Names. 
4) Discusses basics of accessing and using the Create Template dialog to create templates 

or combine components.  

11.2 Section Prerequisites 
• MicroStation Fundamentals 
• Horizontal and Vertical Geometry 
• Proposed Cross-Section Geometry 

11.3 Section Objectives 
After completing this section you will be able to: 
1) Navigate and choose components and templates from RWD.ITL to create Project specific 

templates.  
2) Create Templates from scratch. 
3) Use Template Organizer to copy templates from other ITL files.  

11.4 Project ITL 
MDOT’s standard template library is located at:  
pw:\\pwapp01.mdot.state.ms.us:MDOT_PW\Documents\Workspace\Standards\RWD\ITL\ 
 
Prior to dropping Templates, you need to copy the ITL from the path above to your project 
directory.  You will then create the templates you need by copying pre-built templates to 
the Project Specific folder in the ITL and modifying as needed as discussed in the remainder 
of this section.   
 

  

pw:%5C%5Cpwapp01.mdot.state.ms.us:MDOT_PW%5CDocuments%5CWorkspace%5CStandards%5CRWD%5CITL%5C
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11.5 Create Template 

11.5.1 Opening 

Choosing the following tool invokes the Create Template dialog.  

 
 

11.5.2 Dialog 
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11.5.3 MDOT’s Templates 

The current folder structure is shown below.  Templates have been pre-built for most 
roadway types and with built-in shoulder and subgrade standards.  Components and End 
Conditions have also been built to be able to easily drag and drop to combine different 
component types.  

   
It is highly recommended you copy any templates you need to edit to the Project Specific 
folder prior to editing. This will allow you to import the MDOT structure when updates 
occur without overwriting your project specific templates.  
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11.6 Tools Menu 
This section describes the Tools pulldown menu and a few of the tools available on it that 
you will need to be aware of. 

 

11.6.1 Template Options 

Tools –> Template Options:  Apply Affixes needs to be disabled sometimes and enabled 
sometimes depending on the task you are trying to accomplish.  If enabled a –L or –R is 
added to the points to distinguish Left and Right sides. 
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11.6.2 Dynamic Settings 

Tools -> Dynamic Settings: Dynamic Settings generally needs to be opened and set as shown 
below to construct or move points to specific points.   

 
 

11.6.3 Template Library Organizer  

Allows you to copy components or templates from a library to your current library.   
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11.7 Add Menu 
The Add pulldown menu is how you add elements to the drawing area.   

 
 
The element types available: 
• Simple is a closed shape such as pavement.  
• Constrained or Unconstrained are just lines and generally used for shoulder, ground, 

curb and gutter, etc. 
• Null Point is just a point.  
• End Conditions are just lines but they search for a terrain to solve for and are generally 

the foreslope and backslope.   
• Overlay/Stripping appear in the template dialog as just lines but they expand to the 

terrain as closed shapes in the Corridor Modeling process to create overlay and milling 
areas.   

 
Note:  

• In lieu of using the Add menu to place elements, you can right click the drawing 
area and choose Add New Component. 

 
 

11.8 The Basics 

11.8.1 Adding a component   

1) Right Click and choose Add a component.  
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2) Set the feature type. 

 
 

3) Left click where you wish to place the point.  In the example below; 0,0. 

 
 

4) You can right click to invoke the following menu which allows you to cancel, uncheck 
closed shape, mirror, etc.  

 
 

5) Data point anywhere to place the element and then right click and choose Finish.  
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6) Double click the point placed at 0,0 to invoke the Point Properties dialog, name the 

point, and choose Apply.  

 
 

7) Choose the button next to the Name which allows you to go choose the other point 
placed. 
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8) Name this point, click Apply, and Close this dialog.  

 
 

9) Notice the color of the EP-R point is green.  This indicates this point is not constrained to 
any other point.  
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10) Double click the EP-R point and change Constraint 1 to Horizontal.  

 
11) Choose the Select button to the right of Parent 1 and then left click the CL point which 

populates Parent 1 with CL.  

 
12) Set the Value to 12 and Apply. 
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13) Notice the color of point EP-R now.  It should be yellow which means the point has one 
constraint.  

 
14) Similar to the process above, set the Constraint 2 as shown below and choose Apply. 

 
15) Close the point dialog and notice the color of point EP-R is now red which means it is 

fully constrained.  Also notice the point EP-R is physically located in the drawing area 
where the constraints specify, 12’ right and at a -2% slope from the CL point.  
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16) Right clicking a point invokes the following menu. 

 
 

17) Double Click the line placed which invokes the Component Properties dialog.   

 
Parent Components and Display Rules will be discussed in more depth in the Component 
dialog area below.   

11.8.2 View Commands 

Allow you to fit, zoom in, zoom out, scale, etc. the drawing area.  
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11.9 Point Properties 

11.9.1 MDOT’s Standard Template Point Names   

 
 

POINT CATEGORY DESCRIPTION 
SURFACE FEATURE 

STYLE 
PLAN VIEW STYLE 

CONSTRAINT 
CG-BC Curb Back of Curb 3D PR CONCRETE  
CG-FC Curb Face of Curb 3D PR CONCRETE  
CG-FG Curb Face of Gutter 3D PR CONCRETE  
CL Pavement Top Centerline 3D PR ASHPHALT  
EP Pavement Top Normal Width EP 3D PR ASHPHALT  

EP-W Pavement Top 
Widened EP (Outside 
super) 3D PR ASHPHALT P-EP-PAVED 

EP-X Pavement Top Existing Edge 3D PR ASHPHALT X-EP 
ES-P Shoulder Paved Edge 3D PR ASHPHALT P-SHLD-PAVED 
ES Shoulder UnPaved Edge 3D PR SHOULDER P-SHLD-UNPAVED 
GR-C-DCH Ground Cut Ditch 3D PR GROUND  
GR-C-TIE Ground Cut Tie 3D PR GROUND  
GR-F-CLZ Ground Fill Safety Slope End 3D PR GROUND P-CLEAR-ZONE 
GR-F-TIE Ground Fill Tie 3D PR GROUND  
PV-CL Pavement Bottom Centerline 3D PR ASHPHALT  
PV-EP Pavement Bottom Normal Width EP 3D PR ASHPHALT  

PV-EP-W Pavement Bottom 
Widened EP (Outside 
super) 3D PR ASHPHALT  

PV-EP-X Pavement Bottom Existing Edge 3D PR ASHPHALT  
PV-ES-I Paved Shoulder Bottom Paved Inside Bottom 3D PR ASHPHALT  
PV-ES-O Paved Shoulder Bottom Paved Outside Bottom 3D PR ASHPHALT  
SG-CL Subgrade Subgrade CL 3D PR SUBGRADE  
SG-EP Subgrade Subgrade at EP 3D PR SUBGRADE  

SG-EP-W Subgrade 
Subgrade at EP 
Widened 3D PR SUBGRADE  

SG-TIE Subgrade Subgrade TIE 3D PR SUBGRADE  
SW Sidewalk  3D PR CONCRETE P-SIDEWALK 
ZDNC  Do not Construct   
Znull  Null Points   
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Notes:  

• It is imperative to use this naming convention as close as possible because this is 
what controls the name of breakline features.  

• -L and -R are added to each point for Left and Right sides of the Template. –MR 
and -ML are added for median sides. 

11.9.2 Constraints 

A point can have two constraints.  Point EP-R is constrained to point CL horizontally with a 
value of 12 and by a slope of 2% in the image below.   

   
 
Point Constraint Types 

 
  



 
TEMPLATES  Point Properties 
 

                                     176  

               

11.9.3 Horizontal Feature Constraints 

Below you’ll see an example of a Horizontal Feature Constraint.  Point ES-L is constrained to 
EP-L both by slope and horizontally.  ES-L also has a Horizontal Feature Constraint set so 
that if the feature P-SHLD-UNPAVED is found within a distance of -50’, point ES-L is moved 
to this location.   

 
Note:  

• Horizontal features have to be defined as Corridor Model External References to 
be eligible to be searched for as a Horizontal feature Constraint.   
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11.9.4 Parametric Constraints 

Notice that Constraint 1 below for SG-CL has a Label called Structure Thickness  and a Value 
of -1.5 which is the vertical distance between points CL and SG-CL.  These labels can be 
defined as a Parametric Constraint for a Corridor thus allowing users the ability to define 
project specific values for these labels.   

 

11.10 Component Properties 

11.10.1 Parent Component 

1) Open the following template and uncheck Display Point Names. 

 
 
2) Double click the end condition (green) to the right of the right shoulder. 
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3) You are prompted the following dialog from which you should choose GROUND-FILL-R. 

 
4) Notice the Parent Component of the GROUND-FILL-R component.  

 
 
Parent components basically work in conjunction with Display Rules.  If SHOULDER-R is 
not displayed, GROUND-FILL-R will not be displayed.  
 

11.10.2 Display Rules  

1) Double click the right shoulder to invoke its Component  
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Notice the Display Rule associated with it.  Display Rules can be added by selecting the 
Edit… button here and basically control the display of an element based on specific criteria 
being met.   
 
2) Choose the Edit button to see the Display Rule in detail.  

 
Notice that when the Absolute Horizontal distance is 0, the component is displayed.  
Also note that you can choose Add to add a new rule although this document does not 
cover this process.   
 

3) Choose the Cancel button to exit this dialog and also close the Component Properties 
dialog.  

4) Turn on Display Point Names and zoom to the two points above the CL.  
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5) Right click the top point (Znull-Intersection-R) and choose Test Horizontal Point Control. 

 
 

6) Notice when you move the point, display of the shoulder and ground is turned off.  This 
is because of the display rule on the shoulder and the ground being a child of the 
shoulder.   
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7) Double click the Znull-Intersection-R point and see the Horizontal Feature Constraint is 
set to P-EP-INT.  So the way the display rule works is if Znull-Intersection-R sees a P-EP-
INT feature (an intersection), the point is moved to this location and the horizontal 
distance between this point and the CL is not = 0 and the display of the shoulder is 
turned off.  

 
 
 

Most templates in MDOT’s library are built with Display rules.  A few of these are listed 
below. 
• Find Intersection – If the feature P-EP-INT (an intersection) is found when added as an 

External Reference, end conditions, shoulder, subgrade, and undercut are not displayed 
outside the EP.    

• Undercut – If the Parametric Constraint Undercut Thickness is set to -3, Design Soil (or 
Undercut) will be displayed.  

• X-OVER – If the feature P-X-OVER (a cross-over) is found when added as an External 
Reference, end conditions, shoulder, subgrade, and undercut are not displayed in the 
median.     

• SGLessthan0% - SG alternate based on pavement slope.  
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11.10.3 MDOT’s Shoulder and Subgrade Components 

MDOT’s Open Shoulder component is shown below.  Notice all the points associated with it.  
These points make the shoulder slope match MDOT standards based on pavement slope.  
The Open Shoulder component is complicated and it is recommended you use it even if 
building your own template.   

 

11.11 End Conditions 
An End Conditions is a component that generally targets the existing terrain.  These are 
basically used for the ground outside the shoulder and multiple ones are drawn from a 
single point and each has a priority.  Whichever solves first in the order of priority is the one 
drawn.   
 
Double clicking the ground component you are prompted with the following dialog.   
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Looking at the GROUND-CUT-R component, you see the Priority is 2 and the Target Type is 
set to the Terrain Model.  

 
 
Double clicking the point GR-C-TIE-R you will notice the dialog is similar to a regular Point 
Properties dialog with the exception of the End Condition Properties.  
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11.12 Test (End Conditions) 
When End Conditions are placed, it is good practice to Test them to see how they work and 
this can be done through the Test button shown below.  

 
 

11.13 Active Template 
Allows you to view the points, components, end conditions, display rules, etc. of a template 
as well as showing all non-displayed elements such as the yellow undercut below.  You can 
go in and rename these elements in these lists and also drag components on top of other 
components to make them child elements.   

 

11.14 Overlay/Striping components 
Discussed in the Corridors -> Overlay section.  
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11.15 Creating Templates 
This section covers building templates utilizing the Preview pane and MDOT’s components.  

11.15.1 From Components 

 
1) Under the Project Specific folder, create a new template by right clicking the Project 

Specific folder and choosing New -> Template. 

 
 

2) Rename the New Template to Test. 

 
 

3) Make sure Test is the Current Template. 

 
Note:  

• You double click a template to make it the current template. 
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4) Open MDOT -> Components -> Pavement and single click the New Construction 
template.   

 
  Note:  

• This shows the New Construction template in the Preview pane. 
 

5) Left click and hold down the left mouse button in the Preview pane and drag and drop at 
the 0,0 location in the main template window.   

 
Notes:  

• Right clicked to choose Mirror to place on both the left and right sides at the 
same time.  

• You can use your mouse wheel to zoom in and out. 
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6) Open MDOT -> Components -> Shoulder and single click the Open Shoulder template so 
it is displayed in the Preview pane.  

 
7) Drag and Drop the Open Shoulder template from the Preview pane to the EP-R point on 

the Test template with Mirror On.   

 
Note: 

• CL, EP-R, EP-L, SG-EP-L, and SG-EP-R were all merged to the corresponding Test 
points because they are geometrically the same measurements on each 
template.    
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8) The next step is to open the folder End Conditions and drag and drop the Ground end 

condition to the Test template on point ES-R with Mirror on.  Points EP-L, EP-R, ES-L, and 
ES-R are merged with their corresponding points.  

 
 

 
9) Right Click the Vertical Pavement line under CL and Merge Components to have one 

continuous pavement. 
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LAB VI: Templates 
1. Copy RWD.ITL to your assigned working folder. 
2. Build the following two templates by copying the 2-Lane Open Shoulder and 2-Lane 

Open Shoulder LR templates and modifying to match the dimensions below.  
3. Rename the templates SR4 and LRTuck. 
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12. CORRIDORS 

12.1 Section Overview 
The Corridor Modeling task is Bentley’s application which creates 3d models of highways.  

 

A corridor is created on each given roadway with an established proposed profile.  
Template drops are the type of template you wish to place on a corridor for a given 
station range.   

12.2 Section Prerequisites 
• MicroStation Fundamentals 
• Horizontal and Vertical Geometry basics, Terrain knowledge 

 

12.3 Section Objectives 
After reviewing this section, you will be able to: 
1) Create a Corridor DGN file.  
2) Create a corridor, add template drops. 
3) Modify the corridor with point controls, parametric constraints, etc.   
4) Open a cross-section view 
5) Synchronize templates and process corridors.  

12.4 Best and Required Practices 
1) Corridor DGN files should be created for the mainline roadway for one mile segments 

maximum and for each phase of construction.   Mainline corridors along with all 
adjoining local road and/or auxiliary corridors will be created in these files per phase of 
construction.   
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2) Separate Corridor DGN files should be created for each area between bridges with each 
drop extending into the bridge.  This area will be clipped in the later stages.   

3) Each phase of construction should be represented by a corridor. Phases are not required 
if sheet piling is used with no temporary slopes.   

4) Template Drop Increments – 10’ high speed and 5’ low speed roadways required.  
Corridor stage Phase A is set by default to 5 x INC. = 25’ sections, Phase B is set to 1 x 
INC. = 5’ sections. 

5) Limit clipping which causes processing overhead. Templates are set up to automatically 
turn off end conditions and shoulders through intersection areas when the P-EP-INT 
lines placed with cells are added as external references.  

6) AMG deliverables are discussed more in the AMG Deliverables section in this document. 

12.5 Workflow 
1) Create a Corridor DGN file.  
2) Reference the ALI DGN file.  
3) Reference the TOPO DGN file (File containing the Terrain).  
4) Reference the Superelevation DGN file.  
5) Set the Active Terrain.  Generally this will be a referenced file (SRV-TOPO-001.DGN) 

containing the Terrain or imported TIN.  
6) Create a corridor for the Mainline Alignment.  
7) Add template drop(s). 
8) Associate mainline superelevation information. 
9) Add horizontal and/or vertical controls for particular points (if needed). 
10) Define any transitions and connect. 
11) Review the results and make adjustments.  
12) Add Civil Cells at intersecting roadways, cross-over’s, bridges, etc.  
13) Add external constraints to drop end conditions through intersections and cross-overs. 
14) Add mainline templates.   

 

  



 
CORRIDORS  Create Corridor 
 

                                     192  

               

12.6 Create Corridor 
Once your alignment and profile is created, you can create a Corridor.   

1) Create the file Corridor DGN file using a 2d seed file.  

 

2) Reference the file containing the existing terrain and make it active.  
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3) Open or Fit View 5 and open the Default-3d model. 

 

4) When the Default-3D model was created, it was also attached as reference to View 1.  
Turn off display of this reference to View 1.    
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5) Reference the Alignment DGN file to View 1 (Default model). Default-3d model is 
referenced automatically.  

 
 

 
 

6) Choose the Create Corridor command from the Corridor Modeling menu or the context 
menu by clicking the alignment. 

 or  
 

7) You’re prompted with the following.  Choose the profile or reset if you set the proposed 
profile as the active profile.  

 
The Design stage can and will need to be changed later.  Phase A will give you template 
drops 5 times the template drop increment (normally 5’) which you’ll specify on the next 
dialog. Phase B will give you sections 1 times the template drop increment.   
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8) You’re prompted with the Create Template Drop dialog.  Choose the station range and 

template you want to drop.   

 
 
 

9) Your model should be processed.  
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Note:  
• The template dropped is as drawn in the template library.   

o No superelevation yet. 
o Possibly incorrect lane and shoulder widths. 
o Structure and pavement depth needs project specific adjustment. 
o Clear zone,ditch depth,fill slope, cut slope, etc. possibly need 

adjustment. 
 

The following topics and steps show how to make these project specific adjustments.   

12.7 Context Menus 
Context Menus leading to most of the commands available on the Civil MDOT menu are 
available by choosing the Template Drop or Corridor Handlers shown below and then 
hovering your cursor over them.  These handlers are construction elements.  

 

12.8 Cross-section View 
1) From the corridor context menu, choose the following command to open a cross-section 

view.  

 

2) You will be prompted to Select or Open View. 
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3) The cross section view opened: 

 

12.8.1 View Properties 

Aids you in controlling the cross-section view. 
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12.8.2 Temporary Dimensions 

If you right click the cross-section view, you are provided some specific cross-section view 
options.   

 
 

Place Temporary Dimension Line allows you to place dimensions between cross-section 
points.  
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12.9 Modify Corridor 

 

The tools highlighted above are used for tying template points to graphical elements 
(point controls), defining project specific variables (parametric constraints), etc. Point 
Controls, Parametric Constraints, and External References are discussed in depth in 
subtopic areas below. 

 

 

Edit Template 
Drop 

 

Opens the current template library and displays the template with the selected 
template drop.  While the dialog is the template library interface, keep in mind 
that the editing is only being done to the template within the template drop, 
not the actual template library. Therefore, if any changes are made, the 
template associated with the template drop is no longer in sync with the 
template library. For project specific circumstances, this may be required. 

If the changes are needed in the template library, use the Create Template 
tool. 

 
Point Control Basically, this tool is used to tie template points to horizontal or vertical 

geometry.  For example, tying your ditch point to a ditch profile or tying your 
EP to a graphical, or plan view, EP as shown in the example below.  
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Create Key 
Station 

After prompting for corridor selection and station (entered dynamically or by 
key-in), the station is added to the corridor for processing. This tool is useful to 
add stations that are not coincident with the template interval, when a special 
circumstance of the project occurs (driveway, etc.) and it is desirable to include 
the station in processing.  

 
Create 
Secondary 
Alignment 

Sets parameters for secondary alignments, which are used to modify the 
direction of cross section processing. Requirements include corridor selection, 
secondary alignment definition, beginning and ending station (in cases where 
only part of the alignment element is to be used) and beginning and ending 
offsets. 

 

 

 
Parametric 
Constraints 

This tool allows you to define project specific variables such as pavement 
thickness, structure thickness, clear zone, etc.  

Note: 

• 3’ Design Soil has been added to most templates.  You would create a 
parametric constraint and choose Undercut Thickness and set the 
value to -3 for specific Station Ranges where the Design Soil is 
required.  

 

 
Curve Widening Applies horizontal controls to points to move them farther from the centerline 

at each curve of the controlling alignment. 

 
Create End 
Condition 
Exception 

Defines end condition exceptions, which are used to modify the behavior of an 
end condition solution without requiring the use of additional template drops. 
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Corridor 
Objects 

One-stop viewing of data relating to corridor objects. Excellent for managing 
your corridor data, as it encompasses template drops, key stations, parametric 
constraints, point controls, various references and end condition exceptions all 
within one dialog. 

 
Process 
Corridor 

Processes the corridor to ensure that it is up to date. 

 
 

Note:  

•  (Corridor Objects) Gives you access to all the above plus external references.  You 
can view and/or add new point controls, parametric constraints, end conditions, etc. 
through this tool.  The dialog is shown below. 

  
 

12.10 Point Controls 
 
After the templates are dropped, Point Controls need to be added that tie the template points 
to actual horizontal and/or vertical features.  Some examples include: 

• The template you chose may show 2 - 12’ lanes but your need a 5-lane section.  
• The template you chose is a 4-lane divided template with a CL to CL distance of 88’ but 

you have a variable CL to CL distance through part(s) of your project.   
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12.10.1 Standard Template Point Names 

 

 
 

12.10.2 Adding a Point Control 

 
1) Choose Corridor Objects from the context menu, select Point Control, and choose New.   
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2) Enter a Control Description and choose the point you’re wanting to tie down.  Then, follow the 
prompts.  The example below is tying the CL-L point of a 4-lane divided template to the 
horizontal alignment in the DGN file that represents the CL of the Left Lanes.   

 
 

12.10.3 Example Point Controls 

These examples do not show superelevation point controls. 

1) 4-Lane Divided Template.  

 
 
 
 
 
 



 
CORRIDORS  Parametric Constraints 
 

                                     204  

               

2) 5-Lane Template. 

 
 
Notice the offsets of -30 for the point EP-L.  This will move the template point from a -12’ offset 
to -30’ from the CL alignment (ML). 
 

 

12.11 Parametric Constraints 
Parametric Constraints are the same thing as Define Variables in GEOPAK’s Process Cross-
Section tool.  They allow you to define a value for a given template component.  Some 
examples are Shoulder Width, Pavement Thickness, Structure Thickness, Foreslope, Clear 
Zone, etc.  

 

12.11.1 Adding a Parametric Constraint 

1) Choose the command.  

 
2) Follow the prompts. 
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12.12 External References 
Graphics in DGN files can be added as External Reference for template points outside of the normal 
Point Control assignment.  External References are generally used for cross-overs, intersections, and 
shoulder widening where template points have been told to look for Horizontal Feature Constraints.  
Civil Cells have been created with External References embedded in them so after placement of a Civil 
Cell, just add the intended graphics as External References to the appropriate corridors and end 
conditions, shoulder, and subgrade outside the pavement will be undisplayed from the corridor.  In the 
case of shoulder widening at a bridge, the shoulder will be widened.       

Points with Horizontal Constraints are circled below:

 

12.12.1 Adding an External Reference 

1) Choose the Corridor Objects Tool. 
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2) Select Add New at the top of this dialog after the External References tab is chosen. 

 
 

3) You’re prompted to choose the external references which in the case above were features P-EP-
INT and P-EP-INT1 which were placed with the Intersection cells.  End conditions and shoulders 
of the ML Corridor are turned off as a result.   

12.13 Secondary Alignments  

 

Secondary Alignments are used to change the direction of x-section processing. See the 
yellow cross-section line below.  Note: Generally EP but basically the first plan view 
element intersected and not parallel to the ML.  
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12.14 Applying Superelevation 
Superelevation should be applied next.  See the Superelevation Section for instructions.  
Once applied, Point Controls are added to the corridor.   

 

 

12.15 Synchronize 
If you make changes to a template and want it to be reflected in the template drop, choose 
Synchronize with Library. 
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12.16 Edit Template Drop 
You can edit a Template Drop and not affect the ITL library by choosing edit template drop.  

 

Note: 

• Subsequent Syncs will cause a loss of these edits.  

 

12.17 Process Corridor 
Processes the corridor to ensure it is up to date.  
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12.18 Target Aliasing and Clipping 

A combination of Target Aliasing and Clipping can be used to tie (merge) different corridors together.  
This process is shown below between a ramp and mainline roadway.  

1) Add the ramp taper, ML corridor and existing terrain as Target Alias to the ramp corridor. 

 

 
Note that order of the Aliases does apply.   
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This should give you the following x-section look.  

 
 
 

2) Add a clipping reference of the ramp corridor to the ML corridor and ramp taper corridor. 

 
Results are shown below.  
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12.19 Overlays 
This section discusses the basics of a template Overlay/Stripping component, corridors 
vertical adjustment feature, and the use of both of these features to create the ideal profile 
for overlay and/or milling projects.   
 

12.19.1 Overlay/Stripping components 

A type of component available when creating a template is the Overlay/Stripping 
component as shown below.   
 

 
 
An overlay/stripping component is placed the same way as other template components are 
placed, by defining the component by selecting or creating points. 
 
In the case of an overlay/stripping component, the points of the component define the 
“top” of the component only. The “bottom” of the component is then drawn up or down to 
the existing terrain surface according to the top and bottom options as shown and described 
in the two sections below.  
 
The process calculates values for the top and bottom of the component by looking at all 
existing terrain surface points between the start and end component points, as well as all 
the component points and all intersections where the component segments and surface 
cross. 
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12.19.2 Overlay component settings 

Template settings 

  
 
Results from settings above.  
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12.19.3 Milling Component Setting (Constant) 

Template settings 

 
 
Results from settings above. 
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Below are MDOT’s standard overlay templates.  These templates have two overlay/stripping 
components built into them, one representing overlay and the other representing milling.   
The Pavement Only templates are meant for use in the process of determining the optimal 
vertical alignment. 

 
 
The difference in the constant and variable overlays is shown below.  Constant milling 
templates parallel the existing pavement surface at a specified depth.  Variable milling 
templates parallel the design pavement and the milling is variable across the existing paving 
surface.   
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12.19.4 Vertical Overlay Adjustment 

The Vertical Overlay adjustment tool found on the Corridor Task menu and shown below 
applies the overlay/stripping components to the Corridor based on user input creating the 
ideal vertical profile.  This dialog is described in detail in the steps below.  

 

12.19.5 Steps (Min. Overlay, No Milling) 

The example below will take you through the steps to use the overlay templates to calculate an 
optimal profile for a no mill, variable overlay situation.  

 
1) Create a Corridor DGN file (RWD-CORRIDOR-OVERLAY-001.DGN) (Use a 2d Seed file.) 
2) Reference the alignment DGN file and TOPO DGN file (TOPO contains the existing terrain).  
3) Use Horizontal Geometry Copy command to copy the alignment into this file and turn off display 

or detach the alignment reference.  

 
Note:  

o The alignment is copied because the Vertical Overlay Adjustment does not work with 
referenced geometry.  

 
4) Make the Terrain Active.  
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5) Open the profile model of  the alignment. 

 
 

6) Make the existing profile Active.  

 
 

7) Turn off Display of the Default-3D model in the Default view.  
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8) Create a Corridor called OVERLAY. 

 
 

 
 

9) You should be prompted by the following dialog.  Fill iIf not, choose the Place Template tool from 
the Corridor menu. 
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10) Choose the following template and place it for the entirety of the alignment.  

 
 

11) Open a XS View.  

 
 

 
Note the template is following the existing ground profile.  
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12) Go to Corridor Objects. 

 
 

13) Choose Parametric Constraints and Add New as shown below. 

 
 

14) Choose Overlay Backbone Thickness as the Constraint Label and set the value to -0.25 

 
 

 
 

  



 
CORRIDORS  Overlays 
 

                                     220  

               

15) In Corridor Objects, create the two point controls for the existing EP as shown below.  These 
move the template points to the actual existing EP’s in the SRV-TOPO file.  

 
 

    
 
 

16) If we had superelevation, this would be applied now.  
 

17) Choose the Overlay Vertical Adjustment from the Corridor Modeling task.  
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18) As prompted, choose the corridor and then fill out the dialog as shown below. 

 
 
See below for an example of what the information above represents. 

 
 

19) If the profile view is not open, open it.  
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20) Note the overlay profile adjustment profile created.  

 
 

21) Set it Active 

 
 
 

Before Set Active – Vertical Adjustment not applied 

 

After Set Active – Vertical Adjustment applied.  
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22) Now use Best Fit or Vertical commands to create a profile as close to this overlay vertical 

adjustment profile without going below it. 

 
 

23) Name the profile, set it Active, and export it to annotate or plot it. 
 
 

Other settings and options for calculating the ideal grade are discussed below.  It is ideal 
practice when both Min. Overlay and Maximum Milling are used to create two profiles using 
the steps described above and in the section below and fitting a profile between these two 
profiles.   
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12.19.6 Other Settings 

12.19.6.1 Minimum Milling 
Overlay Vertical Adjustment settings 

 

Results 

 

 

12.19.6.2 Maximum Milling 
 

 

Results 
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12.19.6.3 Minumum Overlay with Milling depth 
Overlay Vertical Adjustment settings 

 
 

Corridor Objects – Parametric Constraint added. 

 

Results 

 
 

12.19.6.4 Minumum Overlay with Variable Milling depth  
Results – Same settings above but with Variable Milling Template 

 
 

  



 
CORRIDORS  Overlays 
 

                                     226  

               

12.19.7 Reports 

12.19.7.1 Component Quantities 
Users can review milling and asphalt quantities based on the profile they established by 
choosing Component Quantities on the Corridor Modeling task as shown below. 
 

 
 

 
 
Changing the profile will affect the amount of overlay leveling and milling required on the 
project which in turn affects the total estimated cost. 
 

12.19.7.2 Milling Report 
Often milling costs are estimated based on the planar area to be milled. The Corridor 
Component Quantities tool provides milling quantities by volume but not by area. To get 
true planar area quantities for milling, use the Roadway Designer Milling Reports tool. 
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Below is an example milling report. 

 
 

 
 
 

LAB VII: Corridor Modeling 
1. Create the file RWD-CORRIDOR-001.DGN (2d Seed file).  
2. Reference SRV-TOPO-001.DGN and Make Active the terrain.  
3. Open the Default-3D model in View 5.  
4. Turn off Display of RWD-CORRIDOR-001.DGN (Default-3d) in View 1.  
5. Reference RWD-ALI-001.DGN, RWD-EP-001.DGN, and SRV-ALI-001.DGN. 
6. Create the Corridor SR4 for alignment ML_SR4. 
7. Drop the ML template created in the previous lab between stations 1056+99.9993 and 

1080+50. 
8. More Corridor processes such as point controls, parametric constraints, etc. will occur 

after the Civil Cells lab, as well as creating a Corridor for LRTuck. 
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13. SUPERELEVATION 

13.1 Section Overview 
With OpenRoads SS4, you can calculate and apply superelevation to Corridors with OpenRoads 
new superelevation tools or calculate superelevation with GEOPAK traditional superelevation 
tool, format, and then import to apply to Corridors. 

13.2 Section Prerequisites 
• MicroStation Fundamentals 
• Horizontal Geometry 
• Basic superelevation knowledge 

13.3 Section Objectives 
After completing this section you will be able to: 
1) Calculate and create superelevation. 
2) Import superelevation from GEOPAK legacy calculations. 
3) Apply superelevation to a corridor. 
 

13.4 Create the Superelevation DGN file 
All superelevation can exist in one DGN file so it is preferred to use one DGN file unless 
overlap in the superelevation graphics causes selection issues or confusion.  
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13.5 Superelevation Tools 
 

Are found under the Corridor Modeling Task.  
 

 

13.6 Steps 

13.6.1 Create Super Sections  

 
One superelvation section should be created for the entire alignment unless the Design 
Speed changes within the alignment. 
 
 
1) Select the Create Super Sections tool. 
2) Type in the name (usually your alignment name) into the heads up prompt: 
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3) Locate your reference element: 

 
4) Select your start and stop stations (or hit alt to lock to the start and stop stations of the 

chain): 

 
 
5) Enter 10000 for the minimum tangent length.   

 
6) Minimum Tangent Length represents the minimum length of tangent between curves.  

OpenRoads will use this to determine how many super sections to create. If 0, a super 
section is created for each curve.  With it set to 10000, only one super section is created 
for the entire alignment.    

 
Completed section: 
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Note:  

• If there are significant changes to the road, i.e., changing from 2 lane rural to 4 
lane divided, separate sections should be created for the appropriate station 
range. 

13.6.2 Create Superelevation Lanes  

 
 
This will create the lanes for super processing.  

13.6.2.1 Process (2-Lane) 
 

1) Select the Create superelevation lanes tool .   
2) Locate the superelevation sections.  You can do this one of two ways.  You can select 

each section one at a time and then reset or you can zoom out, click and drag from the 
upper left side of the screen to the bottom right and release.  This will select all sections 
GEOPAK created in the previous process.  

3) Enter the lane name (RT for the right lane, LT for the left lane).   

 
4) Choose the appropriate centerline side. 

     
5) Enter the offset value for the inside edge. This value is the distance from the centerline 

to lane start. This value is 0 for this example. 

 
6) Enter the lane width.  

     
7) Enter the normal cross slope (-2.00% for normal crown). 
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13.6.3 Calculate Superelevation  

 
 
This will calculate the superelevation from the lanes created in the previous section.   

1) Select the Calculate superelevation tool from the task bar  
2) Select the superelevation sections like before (by using either the select method or the 

click and drag method). 
3) Use the alt+down arrow to access the superelevation standards and select the 

appropriate one.  

 
4) Choose the appropriate e value.  

 
5) Choose the L setting from the drop down.   

 
6) Choose the design speed. 

 
7) Choose linear transition. 

. 
8) Choose the number of lanes. (2 for a 2-lane section, 6 for a 5-lane section,  

 
9) Choose either divided or undivided. 
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10) Choose whether or not you want to open the editor.  If you choose no, you can open the 

editor later using the editor button.  
 
If you have fill turned off in the view, turn it on.  You can see the super lanes created with a 
raindow of colors representing the amount of super in the curves.  
 

 
 
You can edit the super by clicking on the lane.  
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13.6.4 Assigning Superelevation to a Corridor 

 
 
This will allow us to assign the super created in the previous process to a corridor.  
 

1) Select the Assign Superelevation to Corridor tool  
2) Select the superelevation sections like before (by using either the select method or the 

click and drag method). 
3) Locate the corridor. 

 
4) Assign the superelevation points to the correct super object:  
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13.7 Multiple Lanes (5-Lane) 
General steps above can be followed for 5-Lane super but creation of lanes and Assign Super 
to Corridor are discussed below.  

13.7.1 Create Lanes (5-Lane) 

 
A 5-lane requires multiple lanes to be processed.  Three RT lanes (1@6’, 2@12’) and three 
LT lanes (1@6’, 2@12’) will need to be assigned.   
 

 
 

1) Select the Create Superelevation Lanes tool .   
2) Locate the superelevation sections.  You can do this one of two ways.  You can select each 

section one at a time and then reset or you can zoom out, click and drag from the upper left 
side of the screen to the bottom right and release.  This will select all sections GEOPAK created 
in the previous process.  

3) We will create multiple lanes for each side of the roadway.  
a) Enter the lane name RT-1. 

 
b) In the drop down, choose Right.                

 
c) Enter 0 for the offset value.                      

 
d) Enter 6 for the lane width.                            

 
  



 
SUPERELEVATION  Multiple Lanes (5-Lane) 
 

                                     236  

               

f) Enter -2% from the normal cross slope (unless specified otherwise). 

 
 
g) Now, we will add a second lane to the right side. Enter the name RT-2. 

 
h) Choose the Right side of the centerline again. 
i) For the inside edge offset value we will want to use 6 this time.  The first lane you 

created was a 0’ offset from the centerline.  This will offset the currently lane 6’ from the 
centerline since our new lane needs to be created after the RT-1. 

 
j) For the lane width, we need to enter 12 since this is a full lane.  

 
k) Enter -2% for the cross slope. 
l) Now we need to create our final right lane.  Enter RT-3 for the name. 

 
m) Choose the right side of the centerline again.  
n) Enter 18 for the offset value.  (6+12=18) 

 
o) Enter 12 for the lane width. 
p) Enter -2% for the cross slope. Once completed your final right side should look like the 

following:  
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q) Repeat this process for the left side.  The final section will look like this: 

 

13.7.2 Assign 5-Lane to Corridor 

 
In order to properly assign super to corridor for a 5-lane section, you must assign the correct 
point controls.  We created 6 lanes, however we will have to delete some of the point 
controls.  The initial point control box will look like this:  

 
 
When you get this dialog, you need to delete all of the super elevation objects except for LT-
3 and RT-3.  You do this by clicking on the far left box where the arrow is.  Click on each one 
and delete them. The final box should look something like this:  
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Now you need to assign the superelevation point and the pivot point.  The correct 
combination is as follows: 
 

 
Scroll through the cross sections to make sure the superelevation was applied properly. 

 

13.8 4-Lane Divided Superelevation with Median Edge Rotation. 
The same general steps discussed in the 2-lane example can be followed for 4-Lane 
superelevation but creation of lanes and the process of assigning superelevation to the 
corridor is discussed below.  

13.8.1 Establishing the EP profile. 

Use the vertical command Profile By Slope From Element with a slope of 0% and a vertical 
offset of -0.24 to create the profile for the median EP’s.  You’ll choose the alignment that is 
profiled and then the inside EP.  Use this process twice for each lane if you have 2 
independent profiles.  This applies a rule so if the CL profile(s) change, the EP profile also 
changes.   
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13.8.2 Creating Superelevation Section for RTLNS 

RTLN  

 

13.8.3 Create Right Lane Superelevation 

 
RTLN Median Lane (ML) 

 
 
RTLN Outside Lane Right (R) 
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13.8.4 Creating Superelevation Section for Left Lanes 

LTLN  

 
 

13.8.5 Create LTLN Lanes 

 
LTLN Median Lane (MR) 

 
 
LTLN Outside Lane (L) 
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13.8.6 Calculate Super for RTLN’s 

After choosing RT LN superelevation sections: 

 

13.8.7 Calculate Super for LTLN’s 

 

13.8.8 Assign Superelevation to Corridor 

Enter the DGN file that contains your Corridor, reference the superelevation DGN file, and 
select the superelevation Sections.  
 
Choose Assign superelevation to Corridor.  Make edits as shown below.  
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LAB VIII: Superelevation 
 
1. Create the file RWD-SUPER-001.DGN (Use 2d Seed file). 
2. Calculate and Create superelevation for ML_SR4 and LR_Tuck.   

SR4 Steps: 
a. Create the superelevation Section for SR4.  
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b. Create the lanes.  

   
 

c. Calculate the superelevation as show below.  
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Results: 

 
 

3. Enter the Corridor DGN file and reference RWD-SUPER-001.DGN 
4. Apply superelevation to the SR4 Corridor.  
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5. Open Point Controls and view the point controls added.  

 
 

 
6. Open the file RWD-ALI-001.DGN  
7. Reference the RWD-COR-001.DGN (Default-3d to the Alignment DGN files Default-3d 

model). 
8. Open the profile view for alignment LR_Tuck. 
9. Got to Properties from the context menu of the LRTUCK existing profile and name the 

profile XPLRTUCK. 
  



 
SUPERELEVATION  4-Lane Divided Superelevation with Median Edge 
Rotation. 
 

                                     246  

               

10. In the Default view, choose the alignment command Profile from Surface choosing 
LR_Tuck as the element to profile and the pavement mesh of ML_SR4.  
 
 
Command: 

 
 
Pavement Mesh to choose as Reference Surface 

 
 
Profile Created (SR4 Pavement with Super applied) 

 
11. Choose the LR_Tuck profile view to display the Pavement of ML_SR4.  
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12. Create the following profile using Vertical Geometry commands and Civil AccuDraw.   
VPI  S 10+13.9997  EL. 433.0886 GRADE  6.8000%  (Tangent to SR4 Pavement) 
VPI  S 11+50  EL. 438.9366 L 100 
VPI  S 12+50  EL. 442.6183 L 100 
VPI  S 13+59.5191 EL.  444.3575  (Tie to existing ground at End of Profile) 
 

13. Name this profile PPLRTUCK.  
14. Set this profile Active.  
15. Export these to Profiles to the GPK.  
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14. CIVIL CELLS 

14.1 Section Overview 
Civil Cells are pre-built cells placed through GEOPAK’s Place Civil Cell command.  There are 
2D and 3D cells available.  3D cells are used to place 3D geometry in areas that are not 
handled with template runs such as intersections, median cross-overs, bridge spill-throughs, 
etc.   The cells do have quite a few construction elements in them that were used to build 
the cells.  These will not plot and can be ignored unless there is a need to make edits to 
them.   
 
The general procedure to place and then the overview of placement steps for each type of 
Civil Cell is discussed below.   
 

14.2 Section Prerequisites 
• MicroStation Fundamentals 
• Basic superelevation knowledge 
• Horizontal and Vertical Geometry 

 

14.3 Section Objectives 
Ater completing this section, you will be able to: 
 
1) Place MDOT’s Civil Cells. 
2) Modify the Civil Cells vertical geometry to meet project and geomerty specific 

requirements.  
 

14.4 General Procedure 
1) Choose the Place Cell command.  

 
2) Choose which Civil Cell you wish to place by choosing the select button below.  

 
Note:   

• If the button above cannot be selected, reset outside the dialog to activate it.  
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3) Locate and Select the cell you intend on placing.  

 
 

Note:  
• Each cell will prompt you to identify certain elements to let the software know 

where you want to place the cell.  3d cells will require selection of elements that 
have been profile in most cases.  Specifics of pre-requisite elements needed are 
discussed for each cell type below.   

4) Edit the cell with Point Controls, Parametric Constraints, etc. as needed to match your 
project. 

5) Add External References to the ML and local road corridors to drop the shoulder and 
template end conditions through these cells.   

  



 
CIVIL CELLS  Intersections 
 

                                     250  

               

14.5 Intersections 
Intersections cells have to be placed per quadrant.  There are two cells created for each type 
(*-l and *-r).  They are placed for a right or left quadrant based on standing on the ML 
roadway and looking at the local road.  
Notes: 

• Adjustments can be made if you don’t need a taper on one or both ends of the 
quadrant.  

• Parametric Constraints are pre-populated in the cell.   
• The Urban Cells contain Type 3a curb and gutter and have curb and gutter along 

the tapers; the rural, Type 2.  
 

14.5.1 Cells 

 
Notes:  

• Rural is Type 2 curb and gutter 
• Urban is Type 3a 
• INT-C = Simple arc, no tapers 
• INT-TCT = Arc with tapers. 
• *single* = Single island.  

14.5.2 Pre-Requisites 

1) Element representing ML EP with profile through the intersection area extending 300-
400’ either side of the intersection.    

2) Local road CL has profile and extends at least 225’ from the mainline EP for INT-TCT* 
cells.  Intersections with no tapers (INT-C* cells) need to extend 125’ from the mainline 
EP. 

 

14.5.3 Creating the ML EP profile 

The steps to create the partial edge of pavement (ML EP) is shown below.  
 
1) Choose Single Offset Partial from the Horizontal Geometry menu.  
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2) Create this partial element from the ML CL at the edge of pavement offset and 

extending 300-400’ either side of the intersection.  If this element is too short, the Civil 
Cell will not place correctly. 

 
 

3) Choose the Profile By Slope From Element command from the Vertical Geometry menu.  
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4) Enter the slope you wish to project as shown below. 

 
 

5) Following the prompts, choose the EP just created. 

  
 
6) Reset and then locate the reference element which is the ML CL. 

 
 

  



 
CIVIL CELLS  Intersections 
 

                                     253  

               

7) Enter the slope to project and follow the remaining prompts to profile the element 
representing the EP. 

 
 

8) Open the profile view to make sure the profile was created and it is active.  
 
Note: 

• If superelevation is in transition, you need to use the Profile By Variable slope to 
Element. 
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14.5.4 Cell Placement 

Arrow’s for Left Placement:  Local road arrow always towards intersection side you are 
placing Taper-Curve-Taper and mainline arrow always away from the intersection.  

 
 

14.5.5 Editing 

1) Edit the curves to adjust radii. 
2) If taper geometry is edited, also edit the ahead and back tangent ratio’s of the arc.  If 

taper is not needed, change the Ratio-Offset method to None for the appropriate tapers 
and curve.  
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3) Offsets can be edited by selecting one of the parallel construction elements as shown 

below.   
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4) EP vertical has been established based on a normal crown ML and LR.  EP profiles will 
need to be adjusted to match ML and LR Super.  You can choose Properties of parallel 
construction elements to control slope at PC or PT by editing the Project Variable Slope 
variables.  
a) Choose Properties from the parallel construction element that ties into the Begin or 

End taper. 

 
 

b) In the example below, the dialog originally had -2.0% and was changed to +2.8% 
because the curve was in 6.8% super and with a maximum of 4% rollover, 6.8-4 = 
2.8% 

 
  



 
CIVIL CELLS  Intersections 
 

                                     257  

               

5) Tapers – Placed as corridors, super can be applied, or template drop can be removed if 
no taper is needed.   
a) To remove template drop, go to Properties of the template and clear the template.  

   
 

    
 
c) If no tapers, change the Properties of it to a CONST_* level and as mentioned  

earlier, change the Ratio-Offset method to None for the appropriate tapers and 
curve.  
 
Changing EP feature to construction feature: 
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Changing Ratio-Offset to None on the arc for the taper side that was removed. 

 
 

6) Curve Point Control – Will need to be added to arcs to CL point to project to the 
proposed pavement terrain to obtain correct shoulder rotation.  
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7) Add P-EP-INT to the ML and LR Corridors to drop the ML and Taper end conditions 
through the iIntersection.   

 
 
 
 

Before 

 
 

After 
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14.6 Detourand Realignment Takeoff 

14.6.1 Cells 

 
 

 
 
The only difference between the detour and realignment takeoff cells is the templates used 
in the cells have different shoulder widths and end conditions.  Steps below discuss the 
detour takeoff cells but the same information applies to the realignment takeoff cells.  The 
cell: 

 

14.6.2 Detour process 

1) Store horizontal alignments for both ML and DET.   
2) Profile from existing terrain the ML alignment and Make Active the exising profile unless 

you have a grade already set.  
3) Complex ML existing EP on detour side for about 400’ from ML and DET intersection.  
4) Profile from existing terrain the existing EP and Make Active the existing profile.  
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5) Place a short line perpendicular to the ML at PC or PT of detour (where it intersects ML).   
6) Place the Detour-Takeoff-RT-3d or Detour-Takeoff-LT-3d.  Use the appropriate one 

based on a perspective of standing on the ML outside the Detour (Is the detour left or 
right of the ML).  

7) Use Profile from Surface to generate kick-off grades for the detour profile. Choose the 
existing terrain and the asphalt surface placed with the cells.   

8) Create the entire profile of the detour.  
9) You would then drop the detour corridor.  
Reference elements and direction needed for correct placement of Detour-Takeoff-RT-3d:

 
 
Reference elements and direction needed for correct placement of Detour-Takeoff-LT-3d:
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Cell after placement.  

 
 

 

14.7 Guardrail and Bridge Spill Thrus  

14.7.1 Guardrail cells process 

1) Extend ML corridor 50-75’ past bridge abutment.  
2) Place a horizontal element which represents the bridge abutment (BR ABUT below) left 

to right looking at the bridge from the guardrail side.  Use Civil AccuDraw and place this 
at a Station Offset so that it can be easily moved later.   

3) Profile the bridge abutment from pavement surface (From ML corridor). 
4) Extend each end of profile to width of bridge and store profile as complex. 
5) Place the cell.   

14.7.2 Pre-Requisites  

Shown below, Profile on all. 

 
Direction of Arrows needed. 
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14.7.3 Editing 

1) Make any adjustments to guardrail, shoulder, and clear zone needed based on your 
design speed and ADT. 

 
2) Go to Corridor Objects. 
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3) Add the shoulder and clear zone as External References. 

 
 
 
4) Add a Clipping Reference to the corridor. 
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5) Corridor and cell should similar to image below.  

 
 

 
 

6) Open the profile view of the Bent Bottom element.  
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7) Make any adjustments to beam depth here.  

 
 

  



 
CIVIL CELLS  Guardrail and Bridge Spill Thrus 
 

                                     267  

               

8) Adjust bridge to match pavement slope.  
Change the Start and End Slope of the elements circled below to your pavement slope.  
The example below is in 3% superelevation. 

 
 

  



 
CIVIL CELLS  Guardrail and Bridge Spill Thrus 
 

                                     268  

               

The Bent Bottom should now show the profile with the correct slope as shown below.   

 
 
9) Transition the Shoulder Slope and Structure Thickness at the bridge abutment with 

Parametric Constraints.  
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10)  Add End Condition Exceptions through the station limits where point GR-F-CLZ-* rises 
above the SG Tie point.  Exceptions are added because this point does not need to be 
included in the Top Dirt terrain if it is above the SG Tie point.  With the end condition 
below, this point feature is different than the normal feature and excluded in any Top 
Dirt triangulation.  

    
 

14.8 Bridge End Pavement Subgrade Transition 

14.8.1 Cell 

BridgeEnd-SG-Trans 
Used to locate the Subgrade Transition points of the Subgrade Transition leading up to the 
Bridge End Pavement.  Note that you use the same reference elements as used with the 
Guardrail/Bridge Spill-Through cells discussed above.  

14.9 Median Cross-Overs 
Bullet and Semi-Circle x-over cells have been created. 
You need to create a line that represents the X-Over CL and runs 90 degrees off Median EP 
RT to Median EP LT.  This line has to be profiled, as well as having the Median EP’s profiled.  

14.9.1 Cells 
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14.9.2 Pre-Requisites 

1) Median EP LT and RT drawn and have profiles.  Note that these EP’s need to extend 
1000’ each side of the intended X-OVER CL.  

2) Line constructed that represents X-OVER CL and runs 90 degrees off median EP RT to 
Median EP LT and has profile.  
a) Create a line perpendicular to the median RT EP and crossing the LT EP.   
b) Open the profile View of this line.  
c) Use the vertical command Project Profile Intersection Point to show the LT and RT 

EP intersection points. 

 
d) Draw the profile for the X-Over CL and make this profile Active.  
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14.9.3 Steps 

Place the cell. 

 

14.9.4 Edits 

1) Make any adjustments to taper and storage lengths.  
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2) Make any adjustments as needed to the X-Over nose locations.  

 
 
3) Add the P-XOVER features as External References to the ML corridor.   
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4) The turn lane and parallel EP’s drawn were projected at a slope of 2% off the normal 
median EP.  If the X-Over is in superelevation you can: 
a) If constant or variable from beginning to end. 

 
Click the 2d Parallel Lane and go to properties to change the slope if needed. 

 
b) If variable slope and you want to just project and not edit, add CL Point Controls to 

the LT and RT lanes and change the taper Point Control mode from Both to 
Horizontal. 

 
 
 

  



 
CIVIL CELLS  Median Cross-Overs 
 

                                     274  

               

c) If variable slope and you want to project but have the ability to edit, add a 
superelevation auxillary lane.  
Select Create Superelevation Lanes: 
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Fill out the dialog similar to below and choose the Superelevation Section.  

 
 

Fill out the resulting dialog as shown below.  The Follow Adjacent setting will project 
the super of the ML to the auxiliary lane.  
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Once you follow the prompts from the dialog above, the following dialog will appear 
which you can reset out of.   

 
 

The super lane should be added as shown below. 
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Add superelevation Point Control and change the taper point to just Horizontal 
mode as shown below. 

 
 

If super was applied or CL Point Controls added, you’ll notice the taper and parallel 
EP does not line up vertically with the top face of curb.  It needs to match at the nose 
PC to make the x-over terrain accurate so project the superelevation slope at this 
location to the EP by going to the Horizontal Properties of this element and changing 
the slope.   

 
Before slope projection adjustment.

 
Adjustment.  
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After slope adjustment.  

 
 

14.10 Interchange Ramps 
The following steps you through either 2d or 3d interchange ramp cells.  The 3d cells 
available are pre-built with many surface templates, corridors and linear templates.  
These are items you would have to meticulously place if only the 2d cell is dropped. It is 
ideal to go ahead and drop the 3d cell in lieu of its counterpart 2d cell and then change 
vertical and horizontal geometry based on the projects geometry. The reason why is that 
much of the decisions on the horizontal location of the interchange ramp involves 
looking at grades, sight distance, etc.     
 
General Steps: 

1) Place the 2d or 3d cell.   
2) Drop the cell and then complete the ramp alignment tie-in to the crossing roadway.   

If 3d:   
3) Add Const-INT elements placed with the cell to the mainline corridor as External 

References to remove the mainline shoulder and end conditions through the 
interchange area.    

4) If 3d, calculate superelevation, change projected slopes or profiles of the elements 
controlled by these slopes, set complete ramp profile, and apply superelevation.  

5) Add Target Aliasing and Corridor Clips for the overlapping areas of the mainline corridor 
and ramp corridor.   
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14.10.1 Pre-Requisites 

1) ML EP  
2) Line 90 degrees to EP and at location where the Ramp begins.  Place with Civil Accudraw 

and specify station so ramp can be moved later if needed by moving this line.  This line is 
where the parallel lane ends or taper ends for all cells except the tapered exit at which 
case this is where the taper begins.  See image below.  

If 3d Cell: 
3) ML EP profiled at least a 1000’ each direction.   
4) ML Corridor dropped and superelevation applied.   
5) Crossing road profile set, corridor dropped, and superelevation applied. 

 

 
Direction of Arrows needed.

 

14.10.2 Editing 

1) Add the P-EP-INT line as an external reference.  This line is placed on top of the ML EP 
through the ramp and ML intersection area.  
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2) Add the ramp taper, ML corridor and existing terrain as Target Alias to the ramp corridor. 

 
 
 
Target Alias dialog 

 
This should give you the following x-section look.  
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3) Add a clipping reference of the Ramp Corridor to the ML Corridor and Ramp Taper Corridor. 

 
Results are shown below.  

  
 

4) Apply Super to Ramp Corridors.  
 

LAB IX: Civil Cells 
1. Placing cell (realignment-takeoff-3d-RT) 

• In the Corridor DGN file, use Microstation’s Create Complex Chain command to 
create a copy of the TOPO referenced right existing EP, drop it (including 
linestrings), and store complex with a feature of X-EP.   

• Open the profile view of this X-EP and set the existing profile active.   
• Place a line at the BOP on a working or construction level and at 90 degrees to 

the alignment.  This line will be used as a reference.  
• Place the detour cell realignment-takeoff-3d-RT at the BOP. 

2. Place the intersection cells int-c-3d-half-l-Rural and int-c-3d-half-r-Rural at the 
intersection of LR Tucker and SR4.   

• In the Corridor DGN file, copy parallel partial SR4 alignment with a 14’ offset and 
300’-400’ to each side of LRTUCK.  Profile this with the Vertical Profile by slope 
from Element command using +6.8% slope.   

• Place the intersection cells.   
• Add the P-EP-INT lines (four elements on the ML side) in the cell as External 

References to corridor SR4 to turn off display of the SR4 corridor through the 
intersection. 

• Choose Properties from the parallel construction elements that tie into the 
begin/end taper. 
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• Since the superelevation is 6.8%, change the slopes as shown below to +2.8% 
adhering to a maximum 4% breakover value. 

 
 
• Choose Properties of the ML tapers.  
• Change the Slopes of the ML tapers to 2.8% 
• Remove the tapers on the LR side by going to Properties of the template and 

clear the template.  
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• Change the Properties of the LR side tapers to a Construction level and change 

the Ratio-Offset method to None for the appropriate tapers and curve.  

 
 
 

Change Ratio-Offset to None. 

 



 
CIVIL CELLS  Interchange Ramps 
 

                                     284  

               

 
3. Place the Guardrail-3d-2lane cell. (See reference elements needed in the Civil Cell 

instruction area.) 
  

LAB X: Corridor Edits 
1. Create the LRTuck corridor and drop the LR Template created beginning where the civil 

cell ends.   
2. Add the shoulders at the guardrail area as Point Controls.  
3. Change the Beam Depth to 4.5’ 
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15. 3D GEOMETRY TOOLS 

15.1 Section Overview 
3D Geometry tools contain two categories, 3D Tools and Edit.  3D Tools contain tools for 
drawing Civil 3D elements and applying linear and surface templates. Other tools include 3D 
by Volume (useful for pond design) and 3D By Slope to Target which allows the user to 
project a slope to a terrain from a horizontal element that has an active profile.   
 
The Edit Tools contain editing tools for template drops and applied surface templates and 
synchronizing tools for templates with the template library. 
 
Most Civil Cells are created by using some form of linear and/or surface templates.  Linear 
templates are just templates dropped on a linear element that has an active profile and 
without creating a Corridor.  Surface templates are templates inserted into the DGN relative 
to a terrain.  Surface templates generally represent pavement areas of intersections and 
cross-overs.   
 
Most of the edit tools available are available on Context Menus.   

15.2 Section Prerequisites 
• MicroStation Fundamentals 
• Horizontal and Vertical Geometry basics 
• Templates 
• Corridor Models 

 

15.3 Section Objectives 
1) Understand linear and surface templates.  
2) Knowledge of the 3D slope to Target tool.   

15.4 3D Geometry 
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3D Tools 
Select in the Toolbox  Description  

 

Additional 3D by Plan Profile  

The Additional 3D by Plan Profile tool creates a 3D element from a 
portion of a profile line.  

 

Apply Linear Template  

Accesses the Pick Template dialog then inserts the chosen template into 
the drawing relative to a linear element.  

 

Apply Surface Template  

Accesses the Pick Template dialog then inserts the chosen template into 
the drawing relative to a terrain model.  

 

Apply 3D By Slope To Target  

Creates a 3D element computed from a linear element to a surface.  

 

Plan By 3D Element  

Creates a 2D element from a 3D MicroStation element and utilizes the 
original 3D element for the active profile.  

 

Create3D By  Volume  

Creates a terrain modeling computed by volume from another 
reference surface.  

 
 
 

 Edit Tools 
 

Edit Template Drop  

Opens the current template library and displays the template with the 
selected template drop.  

 

Synchronize Template  

Updates a template within a template drop with the template of the 
same name from the current template library. Any changes previously 
made to the template in the template drop are overwritten with no 
warning.  

 

Edit An Applied Surface 
Template  

Opens the current template library and displays the template with the 
selected surface template for editing.  

 

Synchronize Applied Surface 
Template With Library  

Updates a surface template with the template of the same name from 
the current template library. Any changes previously made to the 
template are overwritten with no warning.  
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16. Drainage 

16.1 Section Overview 
This section covers adding profiles for ditches where needed and updating the Corridor to 
reflect these Ditch Profiles and also discussed  

16.2 Section Prerequisites 
• MicroStation Fundamentals 
• Horizontal and Vertical Geometry, Corridor Modeling 

 
 

16.3 Section Objectives 
After completing this section you should be able to: 
1) Drain the corridor.  
2) Profile and determine length of culvert.  

 

16.4 Ditch Drainage 

16.4.1 Overview 

Templates are pre-built to create LOW point alignments/profiles of each side of the 
roadway.   This element is generated from the ditch bottom in cut or the tie point in fill.  
These are Construction elements as shown below and are named LOW-L or LOW-R.  
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You can click on these alignments and use the context menu to open the profile view.   

 
 
You cannot set ditch grades in this profile view and then assign point controls to draw to 
that profile because of circular dependency of the corridor and elements drawn.  The 
process for evaluating, creating, and applying ditch grades is discussed below.   

16.4.2 General Process (Cut Ditches) 

Templates are pre-built to search for the Vertical External Feature P-DCH-RT or P-DCH-LT to 
allow for the easy addition of a Ditch profile in Fill Ditch areas.   
 

1) Process your template.  
2) Open the LOW-L or LOW-R alignments in a profile view.  
3) Draw profiles where needed.  
4) Delete rules of the drawn profiles.  
5) If alignment is referenced, use Horizontal Geometry’s Copy command to copy the element 

in the Corridor DGN file. 
6) Open the profile view of the corridor alignment. 
7) Project the profiles to the corridor alignment.   

Make sure you do not set these as the Active Profile.  
8) Delete the rules of the projected profiles.  
9) Name the profiles. 
10) Add vertical point controls to these ditch profile elements.  

Note:  For each area you are changing the natural ditch grade, you will need to go through 
these steps.   
 

16.4.3 General Process (Fill Ditches) 

Templates are pre-built to search for the Vertical External Reference Features P-DCH-RT or 
P-DCH-LT to allow for the easy addition of a Ditch profile in Fill Ditch areas. 
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16.4.4 Initial Ditch Flow and Setting Grades 

The example below goes through setting grades for the Right Ditch Profile.  You’ll use the 
same process for the Left Ditch, but with different Features.  
 

1) Open the profile view of the LOW-R alignment.   

 
2) Add profiles to drain. 

 
3) Remove the rule created for this element.
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16.4.5 Projecting to the Alignment. 

 
1) If the corridor alignment is referenced, copy the corridor alignment into the DGN file.  

Rename to DCH.   
 

 
2) Open the profile view of this copied alignment. 
3) Choose the Vertical Geometry command shown below. 
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4) Choose the profile that was drawn in the LOW-R profile view and then choose the 
horizontal alignment just created with the Copy command.   You should see the profile 
appear in the DCH view. 

 
 

5) Rename this profile DCH-R. 
 
 

16.4.6 Applying Ditch Profiles to Corridor 

 
1) Go to Corridor Objects. 

 
 
2) Add P-DCH-R as an External Reference.  
 
3) The Ditch profiles should now be a part of your Corridor.    
 

16.5 Pipe Culvert Placement 

16.5.1 Overview 

Roadway has created features for pipes for plan, profile, and 3d views.  A Civil Cell has been 
created for Box Culvert placement.  The steps below show how to place pipes and culverts.    

16.5.2 Process Prerequisites 

1) Corridor placed on roadway that intended drainage is being placed on.  
2) Create a RWD-DRAIN-002.DGN file, reference your existing terrain, make active, and open 

the default-3d model in view 5. 
3) Reference in the DGN containing your roadway corridor, both Default model to View 1 and 

Default-3d model to View 5.    
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16.5.3 Placing a Pipe 

1) Place the pipe in plan view as a horizontal line. 

Length doesn’t matter at this time, just make sure it is initially at or outside your 
construction limits.  
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2) Open a profile view of the pipe alignment.  

 
 

 
 

3) Choose the Vertical Geometry command Profile from Surface. 

 
 

  



 
Drainage  Pipe Culvert Placement 
 

                                     294  

               

4) Choose the pipe and then connection roadway 3d corridor elements (ground and any other 
surface needed in the area of the pipe) when prompted to choose the Reference Surface.  
To help locate this area in a 3d view, open a x-section view of the roadway corridor to see 
the blue line shown below.  

 
 

5) After the prompts, the roadway corridor should be displayed in the profile view.  
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6) Draw your proposed pipe profile. 
a) Vertical command – Place Line from Element. 

 
 

 
 
b) Trim the pipe profile length back to take Flared End Sections into consideration if they 

are present.  
c) If the profile is not as long as the hprizontal pipe drawn, find out what station the profile 

ends at and then change the ending station of the horizontal pipe to match the profile.  

   
 
 
 

  



 
Drainage  Pipe Culvert Placement 
 

                                     296  

               

d) Set the profile active. 

 
 
e) 3d Pipe is drawn when the profile is set active.  

 
 

 
 
f) You can use the Vertical Geometry command Profile from Surface to choose more 

surfaces of your corridor to check for height of cover. 
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16.5.4 Placing a Box Culvert 

1) Place the box culvert CL in the plan view as a horizontal line. 

 
Length doesn’t matter at this time, just make sure it is initially at or outside your 
construction limits. 

2) Follow steps in in the Pipe Culvert section for profile creation.  You should have an active 
profile for the box culvert CL that looks similar to below and the horizontal length should 
have been modified to match the vertical length.  
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3) Copy parallel partial your roadway alignment, 0’ offset, a distance of +/- 100’ from the 
intersection of the box culvert CL.   

 
 

4) Choose the Place Civil Cell command.  

 
 
5) Choose the Box Culvert cell.  
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6) Choose the construction element copied on top of the road alignment.  

 
 
7) Choose the box culvert CL. 

 
 
8) Follow remaining prompts to place box.  You can see 2d and 3d views of the box below.  

2D View 
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 3D View 

 
 
9) The box is default 6’x6’ with associated thicknesses.  Make any adjustments needed as 

shown below.  
a) Select the 2 lines below to modify box width.  

 
 

b) Go to properties on the Working_BOX_TOP* elements to modify height. 

 
 

  



 
Drainage  Pipe Culvert Placement 
 

                                     301  

               

c) You’ll need to modify the profile of the line below on each side of the box to adjust 
the Wing Wall height. 

 
 

d) Wing Wall skew can be adjusted as shown below.  

 
 

e) W height can be modified by opening the profile view of the line below.  
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Finished product in a MicroStation transparent view.  

 
 
 
 
 

LAB XI: Ditching and Drainage 
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17. CROSS-SECTIONS 

17.1 Section Overview 
 

In this section you will learn how to quickly view and create cross-sections with OpenRoads 
tools, label cross-sections, and create cross-section sheets.    

 

17.2 Section Prerequisites 

• MicroStation Fundamentals 

• Knowledge of surveying principals 

 

17.3 Section Objectives 

After completing this Section, you will be able to: 

1) Create cross-sections from a Corridor. 

2) Create Cross-section sheets 
 

 

17.4 OpenRoads XS View 
This process is discussed in the Corridor Modeling section of this document.    

 

17.5 Creating Cross sections 
Creating cross-sections in a DGN file for eventual sheet plotting is performed with the 
following steps.   
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17.5.1 At Even Intervals 

 
1) Create a cross-section (XS) DGN file and enter this file.  (Use xsseed_US.dgn) 

 
 

2) Reference in your alignment file, file containing the terrain, and file containing the 
corridor.  
 

3) Make Active the terrain.  

 
 

4) Choose the Create Cross-Section tool from the Corridor Modeling Task. 

 
 

5) As prompted, Locate Alignment (the alignment you wish to cut cross-sections about). 
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6) The following dialog appears. 

 
 

7) Choose Preferences and choose MDOT XSections.   
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8) Change the Display in View to 2 and change the Station Range, Offsets, Interval as 
needed and then select Apply to create the cross-sections.  
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Notes: 
• Cross sections are created in their own separate model named after the 

alignment they were processed about.  Deleting the model will delete the cross-
sections if you need to re-create them. 

 
• You can use the Cross Section Viewer to navigate through the cross-sections.  

 
 

 
 
• These are traditional GEOPAK working cross-sections so you can use GEOPAK’s 

cross-section labeler, etc. to label.   
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17.5.2 By Pattern Lines 

If you want cross-sections cut at specific stations: 
1) Place pattern lines at the intended locations or stations. 
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2) Choose the Custom tab on the Create Cross Section dialog.   

 
3) Use MicroStation’s select set tool to select the pattern lines.  
4) Change Station Range to Linestring and then select Graphics to fill out the Stations 

of the pattern lines.   

 
 

5) Select Apply to create the cross-sections.   
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17.6 Annotation Cross-Sections 
2) Choose the Annotate Cross Sections tool from the Corridor Modeling task. 

 
 

3) Select Preferences. 

 
 

4) Choose the preference as shown below, choose Load, and then choose Close. 
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5) Set the surface of the Corridor you cut cross-sections about and then Select Apply.  

 
 
The annotations are shown below.  
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17.7 Cross Section Sheets 
1) Create a 2d design file (Use xsseed DGN) (Include the alignment name in the 

Optional_Desc.) 

 
2) Open GEOPAK’s Cross-Section Sheet Composition. 
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3) Active Cross-Section Sheet 
Choose the ACTIVE CROSS-SECTION SHEET at the top of this dialog.  
 
MDOT-10 -> 1”=10’  Single Stacked. 
MDOT-5 ->   1”=5’ Single Stacked 
MDOT-10-DS –> 1”=10’ Double Stacked 
MDOT-20 -> 1”=20’ Single Stack  
MDOT-10-2ew -> 1”=10’ Single Stack (2 EW Phases) 
MDOT-10-3ew -> 1”=10’ Single Stack (3 EW Phases) 
 

4) XS DGN Tab 
Select the XS DGN tab on the left of the dialog and then choose the XS DGN file.  The XS 
Baseline and Beginning and Ending Stations should be filled out automatically. 
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5) Sheet DGN File Tab 
Select the SHEET DGN FILE tab and choose the DGN file you want the XS Sheets created in.  
This will be the DGN file created in step 1. 
 

 



 
CROSS-SECTIONS  Cross Section Sheets 
 

                                     315  

               

6) Sheet Dimensions/Cell 
Select the Sheet Dimensions / Cell tab and make sure the Place Sheet Cell is checked, 
and then enter the name of the Sheet Cell Reference File which will be created. 
 

 
Note: The Sheet cell xsplot or xsplot5 will be placed in the file specified for the Sheet 
Cell Reference File and referenced to your XS Sheet DGN file for each XS Sheet. 
 
 

7) Layout Sheets 
Select LAYOUT SHEETS or FILE -> LAYOUT Sheets on the main dialog. 
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LAB XII: CROSS-SECTIONS 
1. Create cross-sections for corridor SR4.  
2. Annotate the cross-sections.  
3. Create cross-section sheets for the SR4 cross-sections.  
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18. SETTING ROW 
 

18.1 Section Overview 
After limits of construction have been created through the Corridor and Civil Cell 
process, ROW limits can be established and ROW markers placed using Horizontal 
Geometry tools and Civil AccuDraw.  

18.2 Section Prerequisites 
• MicroStation Fundamentals 
• Horizontal and Vertical Geometry basics 

 

18.3 Section Objectives 
After completing this section, you will be able to: 
1) Use Horizontal Geometry to create ROW line work and place ROW Markers.   

18.4 Creating the ROW DGN file 
1) Create and enter the following DGN file.  

 
2) Reference RWD-ALI-001.DGN, SRV-TOPO-001.DGN, and RWD-CORRIDOR-*.DGN 
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18.5 Placing Markers 
Notes:  

• All alignments must be placed using civil geometry or imported with civil rules.  
 
• This method is the same for placing easement points.  Use the feature definition 

P-Easement for the point and ROW-Easements for the line. 
 

1) Turn on Civil AccuDraw and set your origin to the alignment you want your marker 
to be placed off of. Make sure Station-Offset is the active mode. 
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2) Invoke the point command and set the feature to P-ROW. 
 
 

 
 
 

3) Enter the station and offset you want to place the marker on in the Civil 
AccuDraw menu (you must move the mouse to accept the input). 
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4) After you’ve placed multiple markers, you will want to draw the connecting 
ROW line. Invoke the Line Between Points dialog and set your feature to ROW-
LINES.  

 

 
 

Notes:  
• You will need to use origin snap.  
• You can also turn off civil AccuDraw).
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5) Snap to the origin of the first ROW marker and then to the next to complete the line. 
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18.6 Modifying ROW Placement 

 
To modify the marker’s placement, simply click on the marker and change 
the station and/or offset.  The ROW line will move with it. 
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LAB XIII: SETTING ROW 
1. Create the file RWD-ROW-001.DGN and reference the Corridor DGN file to view 

the limits of construction, RWD-ALI-001.DGN, and SRV-TOPO-001.DGN 
 

2. Place the following markers using the P-ROW feature.  
1053+50  50’ RT 
1053+50  90’ RT 
1060+37.5615  90’ RT 
1073+99.4597  90’ RT 
1073+99.4597   135’ RT 
1083+88.3906  140’ RT 
1083+88.3906  115’ RT 
 

3. Place the ROW lines using the ROW-LINE feature.  
 

4. Change the marker at 1073+99.4597 from 135’ offset to 140’ offset.  
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19. EARTHWORK 

19.1 Section Overview 
Surface to Surface Earthwork calculations are accomplished by: 
1. Generating terrains of your Top Dirt surface via AMG preparation steps. 
2. Placing shapes along the intended alignment that match your Plan and Profile 

sheet stationing. 
3. Using the Analyze Volumes Terrain Tool.   
Calculations and shapes used to identify volume areas should be shown in the same 
DGN file in which AMG deliverables are generated. 

19.2 Section Prerequisites 
• MicroStation fundamentals 
• Horizontal and Vertical Geometry basics 

19.3 Section Objectives 
After completing this section you will be able to: 
1) Calculate earthwork between terrains and within the limits of your Plan and 

Profile borders.   

19.4 Steps: Surface to Surface 
 Follow the AMG-Delivery instructions in this document to generate a Top Dirt 
Terrain.   
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1) Create and enter the file RWD-EW-PHASE1-001.DGN to calculate Surface to 
Surface earthwork (Use 2d Seed file).  

 
2) Reference SRV-TOPO-001.DGN, the file containing the existing ground terrain.  
3) Reference RWD-3d-Terrain-D-*.DGN 
4) Place shapes along the alignment that represent the Plan and Profile station 

limits.   
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Note:  
• You can utilize GEOPAK’s Plan and Profile tool with settings as shown below 

to place these shapes. Note the values shown below are for 1”=20’ sheets 
and would need to be changed for 1”=100’.     

 
Note: 

• Choose By station Range: Radial which is not the setting used in Plan and 
Profile sheet setup.   

 
 
5) Choose the Analyze Volumes command from the Terrain tools.  
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6) Choose the From Terrain Model (existing ground terrain) and To Terrain Model 
(Top Dirt terrain). 

 
 
7) Follow the prompts.  When prompted for Boundary, choose the first Plan and 

Profile sheet.  
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8) Click Save Results and then place the volumes by the appropriate boundary 
element.  

 
 
9) Use these same steps to calculate volumes for each boundary.  
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20. PDF CREATION 

20.1 Section Overview 
This section covers PDF plot creation through Plot Organizer and creating PDF’s with 
the correct naming convention.   

20.2 Section Prerequisites 
• MicroStation fundamentals 
• ProjectWise fundamentals 

20.3 Section Objectives 
After completing this Section, you will be able to: 
1) Create a PDF plot set with the PDF having the proper naming convention.   
2) Number sheets automatically.  

 

20.4 PDF creation Process 
While in MicroStation: 
1) Choose Print Organizer from MicroStation’s File pulldown.  
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2) Choose Add Files to Set on the Print Organizer dialog.  
 

 
 

3) Choose Add on the Create Print Definitions dialog.  
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4) Select files, Add, and then choose OK on the following dialog.   
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5) Files are added to the dialog below.  Choose the browse button shown below to 

choose a Print Style.  

 
 

6) Choose the Print Style and select OK.  

  
  Note:  

The PDF Prelim as with other plan specific Print Styles are set to look for line 
style 6 (sheet border style) for the plotting limits and set to maximize to the 
correct paper size of 34.6 x 22. 
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7) Select OK to create the plots. 

 
The PDF Prelim as with other plan specific print styles are set to look for line 
style 6 (sheet border style) for the plotting limits and set to maximize to the 
correct paper size of 34.6 x 22. 
 

8) Arrange the plots with the buttons below to get them in the correct plotting 
order.  

 
 

9) Make sure the Paper Size, Scale, X and Y sizes are all correct.   

 
Note:  
• Plans are always created as a PDF with the size 34.6 x 22 (Full Scale).  They 

can be printed through Adobe at half scale or any scale the user needs.  
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10) Choose File -> Save As… 

 
 

11) Choose No Wizard and fill out the resulting dialog as shown below.  

 
Note: This process saves a .pset in your PW specified folder so that you can open 
it later if you need to re-create the PDF.   
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12) Choose Edit -> Select All to select all plots.  

 
 
 
 

13) Right click the selected plots and choose Print. 
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14) Choose the selected location for the PDF creation.  
 

 
 
 

15) Choose No Wizard, verify the filename, and then select Save.  
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16) Make sure the dialog is similar to what is shown below and choose OK.  

 
 

17) View the PSET and PDF’s created during the process.  

 
 

Note:   
• This example shows the standard file naming convention for the Final ROW 

PDF and PSET. 
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20.4.1 Automatic Page Numbering 

Pre-Req:  $PG$ on your sheets and level on. 

   
 
MDOT has configured their workspace to automatically number plots in Print 
Organizer when creating a plot set and choosing one of their print styles.   
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Actual numbering of sheets is accomplished when the PDF is created by $PG$ on 
each sheet being replaced with the name column value above.  The design script 
assigned when the print style is chosen is the mechanism for performing this 
function.     

 
 

1) If you need to re-number plots, select the plots you wish to number and then 
choose Edit -> Rename by Expression. 

 
 

2) MDOT’s workspace should display with the dialog as shown below: 

 



 
PDF CREATION  PDF creation Process 
 

                                     340  

               

If the dialog does not display the expression shown above, just set the dialog to 
custom and copy and paste the following string to the Specify Expression area.  
 
System.String.Format ("{0:D1}", PrintDefinition.SetPrintDefNumber) 
 

3) If you need to start at a number other than 1, modify as shown below. 
The example is showing starting at 9001. 
 
System.String.Format ("{0:D1}", PrintDefinition.SetPrintDefNumber+9000) 
 
Note:  

• If you have to start sheets at another number further down the PSET (i.e 
3001 for ITS), subtract the number of sheets above the intended 3001 sheet 
from 3000 to get the starting number correct.   

 
 
 

4) Choose OK to rename plots. 
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LAB XIV: PDF CREATION 
 

1. Open any DGN file.  
2. Through Print Organizer, plot the Title and WK files created in earlier steps as a 

combined PDF. 
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21. SMD PROCESSES 

21.1 Section Overview 
 
This section will go through the process of utilizing the District’s Property Map, 
Roadway Design’s ROW, Survey and Design alignments.  Although use of OpenRoads 
Horizontal Geometry commands is covered earlier in this document, the general use 
of these commands as it relates to storing parcels will be covered along with 
GEOPAK’s Coordinate Geometry Store Parcel command to store parcels and create 
deeds.  Also covered will be Bentley Map to access and view GIS parcel data. 
 

21.2 Section Prerequisites 
• MicroStation Fundamentals 
• Knowledge of surveying principals 
• Basic Horizontal Geometry knowledge 

 

21.3 Section Objectives 
After completing this Section, you will be able to: 

1) Access Survey and Roadway Design data in PW. 
2) Create the ROW Acquisition drawing.  
3) Create a Parcel using Horizontal Geometry commands. 
4) Export this parcel to the GPK. 
5) Create a deed using the legal description editor.  
6) Use Bentley Map to view GIS parcel data.  

 

21.4 ProjectWise Processes 
This section discusses the PW SMD structure, accessing Survey and Roadway Design 
data in PW, and creating the Acquisition Map base DGN file. 
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21.4.1 SMD CADD files 

SMD PW CADD work is performed in the following folder.   
 

 
 

21.4.2 ROW PDF Acquisition Map folder 
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21.4.3 Utilizing Survey and Roadway Design Data in PW 

21.4.3.1 PW Folders 
Survey and Roadway Design CADD data is found in the following folders.  It is best 
practice that the SMD user reference any files needed from these folders.  
 
Survey 

 
 
 
 
Roadway Design 
 

 
 

21.4.3.2 Importing Alignments 
See the General Geometry section in this document for detailed instructions but the 
general process is to copy Roadway Design’s GPK, export the alignments needed, 
and then import the alignments needed into the SMD GPK.   
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21.4.4 Creating the Acquisition Drawing 

1) In the SMD folder, choose document new. 
2) Create the following file.  

 
  



 
SMD PROCESSES  Creating Parcels 
 

                                     346  

               

21.5 Creating Parcels 
1) In the file ROW-ACQ-001.DGN file, reference RWD’s ROW, EP, and Alignment 

DGN files.  Also reference the District’s Property and TOPO DGN files.   

 
 
2) Choose Horizontal Geometry’s Single Offset Partial 

 
3) Use this command to copy parallel each element needed to create the parcel 

boundary. 
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4) Use Horizontal Geometry’s command Complex By Elements to complex. 

 
Provide a name and feature and then follow the prompts.  

 
 
Note: 
At this time, there is no Horizontal Geometry command to store a parcel (closed 
shape).  For the time being, use the Complex By Elements command, export to 
the GPK, describe the chain to see what elements are in it, delete the chain, and 
then store the parcel.  This process is described in the steps below.   

 
5) Go to the General Geometry task and choose Export. 

 
 

6) Choose the Parcel(s) to export, reset to accept, then choose the GPK to export 
the parcel(s) to.   

 
7) Enter COGO and select Tools -> Navigator. 
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8) Go through the steps below to see what elements are in the chain.  
 

 
 

9) Delete the chain.  

 
 

10) Choose the Store Parcel command. 
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11) List the elements that should be in the parcel and Store the Parcel.  
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21.6 Legal Description Editor 
The Legal Description Editor is a powerful tool for the automated generation of legal 
descriptions. Its power lies in the completely customizable terminology, styles, and 
preferences, all easily accomplished via dialogs. 

21.6.1 Accessing 
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21.7 Using Bentley Map to plot GIS Data 
 

Below are steps for displaying MDOT’s GIS information in MicroStation through 
Bentley Map including but not limited to parcel data, NGS, county/city boundaries, 
etc.  The steps below discuss opening Bentley Map, connecting to GISPROD (MDOT’s 
GIS data source), displaying available features, labeling features, and displaying 
feature attributes.  The steps below (beginning at the Querying features section) are 
specific to parcels but apply to all available GIS features.   
 

21.7.1 Create the Property DGN 

Create ROW-PROPERTY-001.DGN and enter this file.  Reference the TOPO DGN file 
and fit view.   
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21.7.2 How to start Bentley Map 

 
To start Bentley Map, simply click on the GEOPAK Tab and click Activate Map. 
Bentley map is now ready for use. 
 

 
 
 

21.7.3 Using Bentley Map to retrieve Oracle Spatial Data 

 
1) Create a Map Model by clicking Map Manager from the File menu. 
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2) Fill out the dialog as shown below and select OK.  Note the name is custom and 
will generally change based on what GIS information you are wanting to pull.   

 
 
The new MicroStation model is created and opened.  

 
 

3) Reference TOPO to this model and fit view.  
4) Open Map Interoperability. 
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5) Open the MDOT’s Graphical Source - GISPROD 

 
 
 

6) Log on to the data source 

 
User – publicuser 
Password – password 
 
We are now fully connected and setup to start querying data from the Oracle 
Server and from the Map Interoperability dialog. 
 

  



 
SMD PROCESSES  Using Bentley Map to plot GIS Data 
 

                                     355  

               

21.7.4 Querying features from Oracle 

Querying features is basically the process of displaying graphical GIS features such 
as parcel data in the DGN file.   
 
Below is an image with the categories of features pulled from GISPROD.  
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1) Place a Fence in the area you wish to display data.   

From MDOT-Main, Choose the Place Fence tool and place the fence in the 
approximate location needed.  
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2) Right Click Cadastral Statewide Parcels 2013 under GISPROD’s POLITICAL 
BOUNDARIES category and choose Query.   

 
3) Choose Fence on the Query Features dialog.  This option is not available if 

you didn’t previously place a fence.   
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4) Tag OK if prompted with the following warning.  

 
 
5) Parcel data is loaded.  
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21.7.5 Labeling 

1) In Map Manager right click the item you wish to label and choose Labeling.  
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2) On the labeling dialog, set the labeling style to thematic and choose a label file 
by clicking on the Open button. 
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3) Choose Statewide Parcels.label from Workspace -> Standards -> Bentley Map -
> Labeling as shown below.  

 
 
Labels are displayed.   

                     
Note:  Labels are temporary items and if you exit and re-enter MicroStation, they 
will not be available.  To make these elements permanent in MicroStation, you will 
use the annotation tool as discussed below.   
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21.7.6 Annotations 

1) In Map Manager, right click the layer and choose Annotation. 
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2) You can choose to create a new model for annotations or choose the existing 
model which is the method shown below.  

 
 
 

21.7.7 Feature Data 

You can view information on features by opening Tools -> Geospatial -> Utilities and 
choosing Analyze XFM feature as shown below.  The data presented in the second 
figure below is detailed information about the particular feature selected which in 
this case is a parcel.      
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Choose the command Analyze XFM Feature, and choose the element. The results 
are displayed.   
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22. PHASE “B” PROCESSES 
 

22.1 Section Overview 
This section will cover some of MDOT’s Phase B processes including Summary of 
Quantites, AMG preparation, and surface to surface earthwork calculations. 

22.2 Section Prerequisites 
• MicroStation fundamentals 
• ProjectWise fundamentals 
• Phase B processes 

22.3 Section Objectives 
After completing this Section, you will be able to: 
 
1) Create Summary of Quantity sheets. 
2) Create design terrains for use in AMG and construction inspection. 
3) Calculate estimated earthwork using the surface to surface method.  

22.4 Summary of Quantities 
Below is the SQS.XLSM opened. 
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22.4.1 Copying the XLSM File 

The appropriate SQS XLSM file and associated DGN file should be copied from PW’s 
Workspace\Standards\RWD\SQS\ folder to the RWD-CADD_Files_B directory of the 
project.  Below is a list of available files in this folder.  

 
 
Note:  
The _2 or _3 in the file names represent projects that span 2 or 3 counties.  

22.4.2 General Information 

1) This excel spreadsheet is used to create a Summary of Quantities data file for 
Construction division and link to MicroStation for plotting. 

2) Enter the Project Number the excel file is associated with. This field is located 
near the top of column A just above the first pay item selection cell. 

3) All quantity data needs to be entered in this spreadsheet. NO quantity data 
should physically entered in the MicroStation design files. 

4) Retain this excel spreadsheet with its corresponding MicroStation design file. 
This will maintain the link and give the ability to revise items. 

5) This spreadsheet allows the distribution of preliminary project quantities 
without having to access MicroStation. 

6) The most up-to-date Master data source pay items are kept up-to date at the 
following web address server location: 
http://sp.mdot.ms.gov/RoadwayDesign/Pay%20Items/sqs-daily-english.txt 

7) For all users -- to update the pay items list in this spreadsheet, use the Import 
Data from GOMDOT... button under SQS_Options tab on the Ribbon. 

8) The import button updates the Master List worksheet. DO NOT manually modify 
this worksheet.  

9) To generate a data file for Construction Division worksheet, use the Create 
Constructions List option under SQS_Options on the Ribbon. 

10) NEVER manually create your own pay item or modify a pay item description. 
Please contact your supervisor or construction division if a new item is needed. 

11) Column widths: A, B, and C can be changed, all others should not be changed.        
D=16        E=110        F=8        G and H=15 
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12) Row Heights: Row heights should not be changed.  
Row(1)=21        Row(2)=15.75        Black Shaded Rows=20        All Other Rows=12 
Each Sheet has 55 Rows (not including the heading rows 1 and 2) for pay item 
entry.  Do not add or remove any rows, they should remain at 55 rows + 2 for 
the headings. 

13) Hiding and Unhiding Columns: There are two macros available to hide and 
unhide columns.  
The purpose is to hide or unhide the sheet columns (excluding the Preliminary 
columns) to help make it easier to move pay items and quantities together. 
You can run these macros with the buttons on the Ribbon Bar under the SQS 
Options tab. 

 
14) Cell Protection: All uneditable cells have been locked. If you wish to edit them 

you must unprotect the SQS Sheets worksheet with REVIEW > UNPROTECT 
SHEET 

22.4.3 Entering data in the XLSX 

1) Select the SQS Sheets worksheet tab and to make it active.  This tab is where 
you will choose pay items to populate the sheet’s Pay Item Number, 
Description, Unit, and Preliminary quantity.  

 
 

2) To update the Master List of pay items,  select Import data from… button on 
the ribbon. 

 
Notes:  

• The pay item list in the excel file is static. It has to be updated manually with 
the Import button. 

•  RWD automatically updates the source file daily and distributes it to the 
web site server folder. 
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3) Enter a project number the excel file is associated with. This field is located near 
the top of Column A just above the first pay item selection cell. 

 
 

4) Optional: Select a pay item filter grouping in the SQS_Options ribbon under the 
Select Category List field. (Default is to Show All pay items.) 

 
Note:  

• The Pay Item List is very large making it time-consuming to scroll through. 
The filter is used make it easier to find specific types of pay items. 

5) Locate the yellow-shaded column labeled as SELECT A PAY ITEM FROM THIS 
COLUMN TO POPULATE SHEETS. 

6) Select the LIST arrow at the right most end of the cell. Scroll to the desired pay 
item and select it. 

 
7) The Sheet table next to your row selection is automatically populated with the 

pay item number, description, and unit. 
8) If the pay item requires a supplemental description, enter it in the purple-

shaded column. The column is directly right of the yellow column. 
9) If there are Alternate pay items in your list these need to be have an Alternate 

Code entered in the orange column labeled ALT. 
Note:  

• Use AA1 for the first set of pay items and enter AA2 for the alternate set of 
pay items. If other alternates are required use AB, AC, AD, etc. 

10) Continue by selecting additional pay items to fill-in the remainder of the sheets. 
11) Enter the pay items in numerical order. Anticipate inserting pay item later, and 

try to leave blank lines to accommodate these. 
12) The SQS Sheets worksheet contains ten (10) blank SQS sheets for entering data. 
13) Each of the SQS Sheet tables are numbered and each single sheet is designed to 

fit inside a single Roadway Design plan sheet cell. 
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14) Calculate all quantities and manually enter the amounts in the PRELIMINARY 
column for each pay item. 

 
 

15) If you move a pay item to a different line you must also move the quantity 
numbers in the PRELIMINARY column. 

16) You CANNOT insert or delete a column or row to the spreadsheet on the 
SQS_SHEETS tab. 

17) You CAN copy pay items or descriptions in the first 3 columns (A, B, and C 
shaded cells) and paste them to other cells in the same column.  

18) You can delete an item in columns A, B or C by selecting the cell and pressing the 
DELETE key on the keyboard. 

22.4.4 Linking the XLSX to the DGN file.  

1) You can link the sheets in the SQS Sheets worksheet tab at any stage of 
completion.  The link allows updating the MicroStation file to match each sheet. 

2) You can copy a template design file called SQS.dgn located in the folder ...\SQS 
folder to your project or create a new design file. 

Notes:  
• It is recommended that you keep the name SQS.DGN. 
• The template file (SQS.dgn) contains ten (10) blank SQS sheets with guide 

points already placed to help you link the excel spreadsheet data. 
•  If creating your own file, use the cell SQSGUIDE as a guide to linking data. 

The origin of the cell matches the corner of a Plan Sheet border cell. 
3) In this spreadsheet, locate a sheet (example is, Sheet 1) and use a "hold and 

drag" method of selecting the entire sheet.  
Notes:  

• Use the Zoom tool in the lower right corner of excel to scale the view 
enough to see a complete sheet. 

• Select only once sheet at a time and only the items that need linking into the 
design file. 

4) Once the selection is made, use the COPY command in excel to place a copy of 
the selected data into the clipboards memory. 

Note:  
• If you have made changes to the pay item data you must SAVE the file first, 

before doing a COPY. 
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5) With your SQS design file open, position the view in MicroStation at the location 
that matches the sheet number you copied in the previous step. 

6) In MicroStation, select a DZine Menu SQS Paste command.  

 
7) In the MicroStation's TOOL SETTING dialog the tools options for Paste OLE 

(Object-Linking-Embedding) appears. 
8) In the Paste As: field, select LINK. 
Note:  

• DO NOT use Picture or Embedded options. These two options will cause 
problems maintaining a link to this excel file. 
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9) In the Method: field, select BY CORNERS 

 
10) Use the RED active points of the SQSGUIDE cell as the corners that MicroStation 

prompts for you to identify. 
11) You should now have the sheet pasted into MicroStation. Continue to copy and 

paste all the other sheets that you have entered data into on the spreadsheet. 
Note:  

• If you used the SQS template DGN file then you should delete any unused 
sheets in MicroStation to avoid having them located during batch plotting. 

22.4.5 Maintaining the Link 

1) DO NOT delete the excel file. This file must exist to provide a way to update the 
linked sheets in MicroStation. 

2) In MicroStation you can locate and open the excel source by one of the 
following methods: 
a) (Recommended) Use the Selection tool to double-click on the excel sheet 

object and the excel sheet will automatically open in the excel application. 
b) Select the Edit -> Links commands. In the dialog, select from the list of links 

the item you want to open and select the Open Source button.  
 

3) If Excel is opened to a spreadsheet before opening a design file and you double-
click on a linked sheet to open the source, you may get an error message until 
you close the open excel sheet. 

4) After making a revision to a sheet in an Excel file, SAVE it before updating it in 
MicroStation. 

5) To update MicroStation to match a revised Excel sheet, you can use on of the 
following methods: 
a)  (Recommended) Select the Edit -> Update Links options. This will 

automatically update all revisions made in the linked excel sheets. 
b) Select Edit -> Links, then select the items in the list and select the Update 

Now button. 
c) Save and close the saved Excel Sheet. 
d) Select the Update Link option on the DZine SQS menu. 
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22.4.6 Construction Data File 

The following steps are done performed by Construction division.  
1) To create a data file in a format usable by Construction Division can use a 

worksheet tab is located in this Excel file called 4 CONSTRUCTION. 
2) By default this worksheet is empty. To populate the SQS Sheet data into this 

worksheet a macro has been provided within this file. 
3) On the ribbon, locate the SQS_Options -> Create 4 Construction's List option 

and select the icon. This will populate the 4 Construction worksheet based on 
the data in the SQS Sheets tab. 

4) This formatted data on this worksheet can then be exported by Construction.  

22.4.7 Plotting the SQS Sheets 

You may need to exit or close the excel sheet before you plot the objects. When the 
excel data sheet is open, MicroStation may display a diagonal hatching object over 
the spreadsheet. 
Note:  

• This hatching WILL plot as a shaded object. Closing out the excel file will 
eliminate this side-effect. 

 
• The excel SQS sheets have been designed to fit within the limits of a Plan 

Sheet cell when snapping to the red dots on the SQSGUIDE cell. 
 

Using the By-Corner method of placing the link will create the linked object 
with a text size that falls within the normal range of standard text sizes. 

 
• If your SQS design file contains blank sheets then these may plot when using 

the BATCH plotting procedures. 
 
The SQS.DGN template file contains 10 pre-made sheets.  Remove the ones 
that are not used. 
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22.5 AMG Deliverables 

22.5.1 Overview and Required. Practices 

Automated Machine Guidance (AMG) delivery will require the following: 
3) FMS#-ALIGNMENTS.xml 

Design alignments and profiles in LandXML format.  
4) Roadwayname-Phase-TOPDIRT-StationRange.xml  

Top Dirt terrain (In LandXML) for each phase of construction limited to 3 MB of 
file size on the LandXML file.  

5) Roadwayname-Phase-DESIGNSOIL.xml 
Design soil terrain (In LandXML) limited to 3 MB of file size on the LandXML file.  

6) Generation of the files above from 5’ Template Drops and Template drops at all 
horizontal and vertical control points. (10’ allowable for high speed roadways.) 

6) Voids are required in overlay areas. 
7) Channel changes are required and should be designated in the name.  
   

22.5.2 Create Design Terrains (Steps) 

1) Create a DGN file called 3d-Terrain-D-*.DGN (Use 3d Seed file)  
 
3D-TERRAIN-D-roadwayname-(phase)-(stationlimits.DGN).DGN 
 

2) Reference your corridor (Defaul-3d view)  
3) Choose the following Terrain Model command.  
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4) Choose the following Graphical Filter Group.  

 
 

 
5) Fill out the dialog as shown below. 
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6) Select Preview to view the breaklines the filter is seeing. 
No Preview 

 

Preview 

 
 
 

7) Follow the prompts.  

a)  
 

b)  
 

c)  
 

  



 
PHASE “B” PROCESSES  AMG Deliverables 
 

                                     376  

               

Below is an example of a terrain created with the corridor reference for the Defaul-
3d model turned off.   

 
8) Add any drape void areas as needed. (i.e. Overlay Areas). These will need to be 

closed shapes.  In the case of drape voids, no elevation is needed on the 
elements.  In the case of an overlay, it will be the existing EP’s but closed.   
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22.5.3 Create LandXML (Steps) 

 
1) Click the terrain and choose Export -> LandXML. 

 
 
2) Fill out the dialog below and data point through the prompts.  

 
 
3) You’ll be prompted to save the XML file.  Name it the same as the Project Name 

above. 

  

22.5.4 Create GEOPAK TIN 

1) Click the terrain, choose Export -> GEOPAK TIN, and follow prompts. 

 
Note:  

• You can use this TIN to cut XS’s from surface on top of the x-sections created 
from the corridor to verify the terrain accuracy.  This QC process is highly 
recommended. 
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LAB XV: AMG Deliverables 
1. Create the file RWD-3D-TERRAIN-D-TOPDIRT.DGN 
2. Reference the corridor file. 
3. Create the Top Dirt terrain for corridor SR4.  
4. Create the Finished Grade terrain for corridor SR4.  
5. Export these terrains to XML and TIN files.  
6. Create cross-sections from the TIN files on top of the design cross-sections 

generated earlier to verify TIN accuracy.   
 

LAB XVI: Earthwork 
1. Create the file RWD-EW-PHASE1-001.DGN 
2. Reference your Border DGN file.  
3. Calculate earthwork per sheet.  
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